Visual QuickStart Guide

Flash Professional CS5

Get up and running in no time!

Katherine Ulrich

Learn the quick and easy way!
Contents at a Glance

Introduction ................................................................ xiii

Chapter 1  The Flash Authoring Tool .................................................. 1

Chapter 2  Creating Simple Graphics .................................................. 29

Chapter 3  Working with Text ............................................................... 69

Chapter 4  Modifying Simple Graphics ................................................. 105

Chapter 5  Complex Graphics on a Single Layer ................................... 153

Chapter 6  Graphics on Multiple Layers .............................................. 171

Chapter 7  Working with Symbols ....................................................... 193

Chapter 8  Frame-by-Frame Animations ................................................ 215

Chapter 9  Animation with Classic Tweening ....................................... 249

Chapter 10 Animation with Shape Tweening ....................................... 271

Chapter 11 Animation with Motion Tweening ..................................... 287

Chapter 12 More-Complex Animation Tasks ....................................... 333

Chapter 13 Intro to Inverse Kinematics ................................................. 373

Chapter 14 Building Buttons for Interactivity ...................................... 409

Chapter 15 Basic Interactivity ............................................................... 431

Chapter 16 Using Non-Flash Graphics. ................................................ 489

Chapter 17 Adding Sound and Video ................................................... 499

Chapter 18 Delivering Movies to Your Audience ................................... 537

Index ................................................................................................. 563
This page intentionally left blank
# Table of Contents

Introduction ........................................... xiii

**Chapter 1**  The Flash Authoring Tool .......... 1
   Working with Flash Documents ................. 2
   Working with Template Documents .......... 6
   About the Flash Authoring Environment .... 8
   Using Panels ...................................... 11
   Setting Document Properties ................. 16
   Using Rulers, Grids, and Guides .............. 21
   Working with Snapping ......................... 24
   Practice Session .................................. 28

**Chapter 2**  Creating Simple Graphics ........ 29
   Touring the Tools .................................. 30
   Creating Solid Colors and Gradients ...... 33
   Working with Swatches ......................... 39
   Setting Fill Attributes ......................... 40
   Setting Stroke Attributes ..................... 43
   Making Geometric Shapes ...................... 46
   Creating Free-form Shapes .................... 53
   Adding Strokes and Fills ...................... 63
   Practice Session .................................. 68

**Chapter 3**  Working with Text ................. 69
   Creating TLF Text Fields ....................... 72
   Creating Linked Text Fields ................... 76
   Setting Character Attributes ................. 84
   Setting Paragraph Attributes ................. 95
   Setting Container Attributes ................. 98
   Practice Session .................................. 104

**Chapter 4**  Modifying Simple Graphics ....... 105
   Setting Selection Preferences ................. 106
   Making Selections ................................ 107
   Resizing Graphic Elements .................... 113
   Positioning Graphic Elements ................. 117
   Flipping, Rotating, and Skewing .............. 119
<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Complex Graphics on a Single Layer</th>
<th>153</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Working with Groups</td>
<td>156</td>
</tr>
<tr>
<td></td>
<td>Editing Groups</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Controlling Stacking Order</td>
<td>160</td>
</tr>
<tr>
<td></td>
<td>Combining Drawing-Objects and Primitives</td>
<td>162</td>
</tr>
<tr>
<td></td>
<td>Creating Patterns</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Practice Session</td>
<td>170</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Graphics on Multiple Layers</th>
<th>171</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Touring the Timeline's Layer Features</td>
<td>172</td>
</tr>
<tr>
<td></td>
<td>Creating and Deleting Layers and Folders</td>
<td>173</td>
</tr>
<tr>
<td></td>
<td>Setting Layer Properties</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Organizing Layers</td>
<td>178</td>
</tr>
<tr>
<td></td>
<td>Working with Graphics on Different Layers</td>
<td>180</td>
</tr>
<tr>
<td></td>
<td>Cutting and Pasting Between Layers</td>
<td>182</td>
</tr>
<tr>
<td></td>
<td>Distributing Graphic Elements to Layers</td>
<td>185</td>
</tr>
<tr>
<td></td>
<td>Working with Guide Layers</td>
<td>186</td>
</tr>
<tr>
<td></td>
<td>Working with Mask Layers</td>
<td>188</td>
</tr>
<tr>
<td></td>
<td>Practice Session</td>
<td>191</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Working with Symbols</th>
<th>193</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Using the Library Panel</td>
<td>194</td>
</tr>
<tr>
<td></td>
<td>Converting Graphics to Symbols</td>
<td>197</td>
</tr>
<tr>
<td></td>
<td>Creating Symbols from Scratch</td>
<td>201</td>
</tr>
<tr>
<td></td>
<td>Using Symbol Instances</td>
<td>203</td>
</tr>
<tr>
<td></td>
<td>Modifying Symbol Instances</td>
<td>204</td>
</tr>
<tr>
<td></td>
<td>Editing Master Symbols</td>
<td>208</td>
</tr>
<tr>
<td></td>
<td>Deleting Master Symbols</td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Converting Symbol Instances to Graphics</td>
<td>211</td>
</tr>
<tr>
<td></td>
<td>Swapping One Symbol Instance for Another</td>
<td>212</td>
</tr>
<tr>
<td></td>
<td>Practice Session</td>
<td>214</td>
</tr>
<tr>
<td>Chapter 8</td>
<td>Frame-by-Frame Animations</td>
<td>215</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Optimizing the Timeline</td>
<td>217</td>
<td></td>
</tr>
<tr>
<td>Creating Keyframes</td>
<td>219</td>
<td></td>
</tr>
<tr>
<td>Creating In-Between Frames</td>
<td>223</td>
<td></td>
</tr>
<tr>
<td>Selecting Frames in Keyframe Spans</td>
<td>225</td>
<td></td>
</tr>
<tr>
<td>Manipulating Frames in One Layer</td>
<td>228</td>
<td></td>
</tr>
<tr>
<td>Removing Frames</td>
<td>232</td>
<td></td>
</tr>
<tr>
<td>Making a Simple Frame-by-Frame Animation</td>
<td>235</td>
<td></td>
</tr>
<tr>
<td>Previewing the Action</td>
<td>238</td>
<td></td>
</tr>
<tr>
<td>Setting the Frame Rate</td>
<td>241</td>
<td></td>
</tr>
<tr>
<td>Varying Frame-by-Frame Speed</td>
<td>242</td>
<td></td>
</tr>
<tr>
<td>Using Onion Skinning</td>
<td>244</td>
<td></td>
</tr>
<tr>
<td>Editing Multiple Keyframes</td>
<td>246</td>
<td></td>
</tr>
<tr>
<td>Practice Session</td>
<td>248</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9</th>
<th>Animation with Classic Tweening</th>
<th>249</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Bouncing Ball with Classic Tweening</td>
<td>251</td>
<td></td>
</tr>
<tr>
<td>Adding Keyframes to Classic Tweens</td>
<td>256</td>
<td></td>
</tr>
<tr>
<td>Moving Symbols in Straight Lines</td>
<td>257</td>
<td></td>
</tr>
<tr>
<td>Moving Symbols Along a Path</td>
<td>259</td>
<td></td>
</tr>
<tr>
<td>Animating Changes in Size</td>
<td>263</td>
<td></td>
</tr>
<tr>
<td>Rotating and Spinning Graphics</td>
<td>265</td>
<td></td>
</tr>
<tr>
<td>Animating Color Effects</td>
<td>268</td>
<td></td>
</tr>
<tr>
<td>Practice Session</td>
<td>270</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10</th>
<th>Animation with Shape Tweening</th>
<th>271</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Bouncing Ball with Shape Tweening</td>
<td>272</td>
<td></td>
</tr>
<tr>
<td>Morphing Simple Lines and Fills</td>
<td>275</td>
<td></td>
</tr>
<tr>
<td>Shape-Tweening Multiple Shapes</td>
<td>277</td>
<td></td>
</tr>
<tr>
<td>Transforming a Simple Shape into a Complex Shape</td>
<td>279</td>
<td></td>
</tr>
<tr>
<td>Creating Shapes That Move As They Change</td>
<td>283</td>
<td></td>
</tr>
<tr>
<td>Practice Session</td>
<td>286</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11</th>
<th>Animation with Motion Tweening</th>
<th>287</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Bouncing Ball with Motion Tweening</td>
<td>288</td>
<td></td>
</tr>
<tr>
<td>Working with Motion-Tween Paths</td>
<td>297</td>
<td></td>
</tr>
<tr>
<td>Orienting a Tween Target to a Curved Path</td>
<td>303</td>
<td></td>
</tr>
<tr>
<td>Swapping Tween Elements</td>
<td>304</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 12 More-Complex Animation Tasks

- Manipulating Frames in Multiple Layers
- Animating on Multiple Layers
- Reversing Animation
- Saving Animations As Symbols
- Using Animated Graphic Symbols
- Using Movie-Clip Symbols
- Using Easing
- Re-creating Classic and Motion Tweens
- Practice Session

Chapter 13 Intro to Inverse Kinematics

- Using Armatures to Connect Symbols
- Creating IK Shapes
- Working with Poses
- Constraining IK Motion
- Editing IK Elements
- Practice Session

Chapter 14 Building Buttons for Interactivity

- Creating a Basic Button Symbol
- Creating Shape-Changing Button Symbols
- Creating Fully Animated Button Symbols
- Using Button Components
- Modifying Button Components
- Creating Movie-Clip Buttons
- Practice Session

Chapter 15 Basic Interactivity

- Touring the Actions Panel
- Customizing the Actions Panel
- Adding Frame Actions
- Programming Buttons with Frame Scripts
This page intentionally left blank
Adobe Flash Professional CS5 is the latest version of the enormously popular web design tool. In its original incarnation, Flash gave web designers an efficient way to send artwork and animation over limited-bandwidth connections. Flash’s claim to fame was its ability to deliver vector images over the web, making download times shorter. Flash’s use of progressive downloading and streaming allowed some elements of a website to display immediately, making sites more responsive.

Today Flash is a robust toolkit for creating anything from simple animations to full-fledged websites and complex web applications. To the simple tools for creating and animating artwork and interface elements and writing the HTML necessary to display all those elements in a web page via a browser, Flash adds a full-fledged object-oriented scripting language, the ability to display video, and ever-more sophisticated text, graphics, and animation tools.

Flash CS5 offers a new tool for working with text—the text-layout framework (TLF)—which gives you access to a wide range of typographic effects and text-layout methods. New deco-tool patterns create repetitive elements, such as flowers, trees, and buildings; there are also animated patterns for flames, smoke, and particle generators. Additions to the properties of IK bones let you simulate physical forces acting on items animated with inverse kinematics. A new Color panel makes it easier to define colors, enhancements to the code editor in the Actions panel make working with ActionScript in the authoring environment easier, and the addition of a Code Snippets panel helps with common scripting tasks.

**How Flash Animates**

Flash lets you use standard animation techniques to create the illusion of movement. By displaying a series of still images—each slightly different from the next—one after another, you simulate continuous movement. Flash CS5 lets you use five animation techniques in the authoring environment (you can also create animation through ActionScript, although that is outside the scope of this QuickStart Guide). With frame-by-frame animation,
behind-the-scenes format and structure for the materials created in Flash: XFL (a version of XML—extensible markup language—for Flash). The XFL format stores the assets, data, and code that make up a Flash movie as separate sub-files. By default, Flash compresses the XFL and hides that structure from you. When you choose File > Save, Flash saves the artwork, animation, and interactivity you've created in a traditional Flash-format file. These files have the extension .fla and are often referred to as FLAs. The tasks in this book assume you will continue to work with the compressed XML file, which looks and acts like a traditional Flash file. If you want to be able to access the subfiles that make up your movie—so that, for example, you can use them in other applications that understand XML (such as Adobe Photoshop, Illustrator, or After Effects)—choose File > Save As, then save your Flash content in Flash CS5 Uncompressed Document (.xfl) format. To make Flash content viewable on the web, you convert the FLA files to Flash Player format; Flash Player files have the extension .swf and are often referred to as SWFs.

Flash Interactivity
Over the years, Flash's tools for creating interactivity have become more robust. Flash CS5 contains a full-fledged object-oriented scripting language, in two versions: ActionScript 2.0 and 3.0. Both are compliant with the ECMA-262 specification, which is also the foundation for JavaScript, so they should feel familiar to anyone who already knows JavaScript. With ActionScript, Flash has become a toolkit for creating web applications which might be anything from an online store to a corporate training module to a video-clip—display site to a snazzy promotional piece describing this year’s hottest new car, complete with customizable virtual test-drives.

Flash File Formats
Flash provides both an authoring environment for creating content and a playback system for making that content viewable on a local computer or in a web browser. With Flash CS5, Adobe introduces a new behind-the-scenes format and structure for the materials created in Flash: XFL (a version of XML—extensible markup language—for Flash). The XFL format stores the assets, data, and code that make up a Flash movie as separate sub-files. By default, Flash compresses the XFL and hides that structure from you. When you choose File > Save, Flash saves the artwork, animation, and interactivity you've created in a traditional Flash-format file. These files have the extension .fla and are often referred to as FLAs. The tasks in this book assume you will continue to work with the compressed XML file, which looks and acts like a traditional Flash file. If you want to be able to access the subfiles that make up your movie—so that, for example, you can use them in other applications that understand XML (such as Adobe Photoshop, Illustrator, or After Effects)—choose File > Save As, then save your Flash content in Flash CS5 Uncompressed Document (.xfl) format. To make Flash content viewable on the web, you convert the FLA files to Flash Player format; Flash Player files have the extension .swf and are often referred to as SWFs.

How Flash Delivers
Flash’s publishing feature creates the necessary HTML code to display your Flash content in a web browser. You can also choose alternate methods of delivering Flash content—as animated GIF images, for example. Flash creates the alternate files during the publishing process.
Flash CS5: What’s New?

This version of Flash offers a significant new text tool for designers: TLF text. There are also user-interface improvements, new deco-tool patterns, improvements to the scripting facilities of the Actions panel, predefined ActionScript code snippets, and a new behind-the-scenes file format. Let’s look at some highlights of Flash CS5.

Interface Enhancements

Color Panel A redesigned Color panel simultaneously displays all the properties of a color (hue, saturation, brightness, red, green, and blue) A.

Info Panel Hot-text controls in the Info panel let you change property settings for selected objects on the Stage interactively.

Design Enhancements

Text-Layout Framework There’s a new way of working with text: the text-layout framework (TLF). TLF gives Flash designers access to a huge new set of typographic tools for use within the Flash authoring environment. TLF creates linked text fields, with threaded text B. Threaded fields simplify the process of designing multiple-column text that wraps around graphic elements. Threaded text reflows within the linked fields as you add and/or delete text or change sizes and fonts. TLF can also

continues on next page
create multiple columns of text within a single text field. TLF can create vertical and horizontal text, reading left-to-right or right-to-left. TLF text supports Asian text and lets you control many advanced typographic details, such as ligatures, number styles and number alignment, leading, tracking, padding, indents, column gutters—all appropriately implemented for the language and locale you are working with.

**Improved Font Embedding** The new Font Embedding dialog lets you embed subsets of glyphs (characters) from the fonts you use (say, all uppercase and lowercase letters) rather than embedding all the glyphs in the font. This helps keep down file sizes.

**Expanded Deco Tool** The deco tool offers many new pattern types. There are patterns for creating organic elements, such as flowers and trees. There’s a pattern for creating buildings. Some of the new patterns create animation—for example, animated flames, smoke, lightning flashes, or particles spewing from a single source.

**Animation Enhancements**

**Springy Bones** New properties for IK bones let you simulate the effect of physical forces on the jointed armatures you create with inverse kinematics.

**ActionScript Enhancements**

**Code Completion** Flash now automatically imports custom classes as well as built-in classes in ActionScript 3.0, which means that you can get code hints for custom classes when you use the script pane of the Actions panel.
Automatic Close-Bracket Insertion You can choose to have Flash automatically create paired brackets: whenever you type an open bracket (]) in the Actions panel's Script pane, Flash adds a line for entering a statement, adds a closing bracket (]) to end the statement, and creates indents appropriate to the nesting level of the bracketed statement.

Code Snippets Panel Flash CS5 offers a selection of predefined ActionScript 3.0 scripts. These commented blocks of code create scripts for basic interactivity tasks, such as navigating the Timeline, linking to web pages, and animating selected objects. Some snippets offer building blocks of code for creating event handlers. The panel also lets you create custom snippets using your own code.

Collaboration, Cross-pollination, and More

XFL Format Behind the scenes, Flash CS5 uses a new format—XFL—that is based on XML. By default, Flash compresses the XFL files and wraps them up in the familiar FLA file format, so you can continue to work with FLA and SWF files as in earlier versions. You do have the option to work with uncompressed XFL files, in which the various assets and pieces that make up the Flash movie get saved as individual subfiles. In some workflows, the ability to access these files separately makes it easier for designers and coders to collaborate and work with data and assets in various Adobe applications.

XFG Format Flash CS5 exports to Adobe XFG format, an XML-based graphics interchange format that enables you to work on items in other Adobe graphics applications, such as Illustrator.
Automatic Update of Photoshop Edits  You can access Photoshop CS5 to edit bitmaps from inside your Flash movie; edits you make to the original source file automatically update in your Flash movie.

Video Preview  The FLVPlayback component that you can use to display video clips in Flash now plays its video live on the Stage during authoring. You no longer have to test a movie to see the video in action. In addition, you can set cue points (for controlling video with ActionScript) in the Properties panel in the Flash authoring environment. And there are new space-saving skins for creating video controls for your video clips.

How to Use This Book

Like all the books in the Visual QuickStart Guide series, this one seeks to take you out of passive reading mode and help you get started working in the program. The tasks in the book teach you to use Flash’s features. The book is suitable for beginners who are just starting to use Flash and for intermediate-level Flash designers. The initial chapters cover the basics of creating graphic elements by using Flash’s unique set of drawing tools. Next, you learn how to turn graphic elements into animations. After that, you learn to create basic user-interface elements, such as rollover buttons. To make your content interactive, you’ll work with the Actions panel to create ActionScript for basic interactivity. You’ll also learn about importing and working with various non-Flash content: artwork from other applications, sounds, and video. Finally, you’ll learn to use Flash’s Publish feature to create HTML for putting your Flash creations on the web. At the end of each chapter in this book, you’ll find a section named Practice Session. The ideas in these sections are designed to spark your imagination and reinforce the learning provided by the chapter’s individual tasks. The Practice Sessions are not intended to create a comprehensive project for you to complete, although materials created in early sessions can be used in later practice sessions.

What You Should Already Know

In order to get you started quickly, this book makes a few assumptions:

- Adobe Flash CS5 is already installed on your computer.
- You’re familiar with the workings of your operating system.
- You can carry out basic tasks, such as opening, closing, and saving documents; opening, closing, resizing, collapsing, and expanding document windows and dialogs; using hierarchical menus, pop-up menus, radio buttons, and checkboxes; and carrying out standard application commands such as copy, cut, paste, delete, and undo.

Cross-platform Issues

The Flash authoring environment has a very similar interface on the Macintosh and Windows platforms. Still, differences exist where the user interfaces of the platforms diverge. When these differences are substantial, I describe the procedures for both platforms.

Originally, Macintosh computers required Macintosh keyboards, and some key names were unique to that keyboard: for example, Return (instead of Enter) and Delete (instead of Backspace). I generally uses Enter and Delete for these two key names.
**Keyboard Shortcuts**

Most of Flash’s menu-based commands have a keyboard equivalent. That equivalent appears in the menu next to the command name. When I introduce a command, I also describe the keyboard shortcut. In subsequent mentions of the command, however, I usually omit the keyboard shortcut.

**Contextual Menus**

Both the Macintosh and Windows platforms offer contextual menus. To access one of these contextual menus, Control-click (Mac) or right-click (Windows) an element in the Flash movie. You’ll see a menu of commands that are appropriate for working with that element. For the most part, these commands duplicate commands in the main menu; therefore, I don’t generally note them as alternatives for the commands described in the book. I do point out when using the contextual menu is particularly handy or when a contextual menu contains a command that is unavailable in the main menu bar.

**Artwork, Scripts, and More**

The Flash graphics in this book are easy to draw. Most of the examples are based on simple geometric shapes, which means you can spend your time seeing the Flash features in action instead of re-creating fancy artwork. To make it even easier, Flash files containing the graphic elements that you need for each task are available on Peachpit Press’s companion website for this book. In Chapter 15, you’ll learn to create scripts for basic interactivity, and Flash files containing the completed scripts for these tasks are also available. In addition, the site offers some bonus tasks that I just couldn’t squeeze into the pages of this book.

To access the files, you must register at www.peachpit.com. Click the Account Sign In button to create an account (or log in to your existing account). Click the “Register your products here” (or “Register another product”) link and enter the book’s ISBN (0321704460) in the text field that appears. A link to the supplemental content will appear on your account page. You should also be able to download the files by registering or logging into your account at www.peachpit.com/flashcs5vqs.
This page intentionally left blank
One way to modify graphics in Adobe Flash Professional CS5 is to select one or more shapes and edit them by changing their attributes (such as color, size, and location) in the Property inspector or in other appropriate panels.

You can also modify the path that creates the shape of an element. Some operations—such as straightening lines, adjusting Bézier curves, and assigning new attributes—require that the element be selected. Others, such as reshaping a line segment or curve with the selection tool, require the element to be deselected. A few operations let you edit the element whether it’s selected or not—using the paint-bucket tool to change a fill color, for example.

This chapter covers using the selection, lasso, and subselection tools to select and modify the elements you learned to make in Chapter 2. You also learn about using the Property inspector and other panels to modify elements’ attributes.

In This Chapter

- Setting Selection Preferences 106
- Making Selections 107
- Resizing Graphic Elements 113
- Positioning Graphic Elements 117
- Flipping, Rotating, and Skewing 119
- Distorting Graphic Elements 123
- Modifying Fills and Strokes 126
- Modifying Shapes: Natural Drawing Tools 133
- Modifying Shapes: Bézier Tools 136
- Modifying Primitive-Shape Paths 144
- Converting Shape Types 149
- Practice Session 152
Setting Selection Preferences

There are two basic ways to make a selection in Flash: one is to click an element directly, and the other is to enclose all or part of an element with a selection outline. You can set preferences to gain more control over these two methods. For the click method, you choose whether you must Shift-click to select multiple items or whether you can merely click additional items to add to a selection. For the selection-outline method, you decide if the outline must fully enclose a graphic-object to select it or if enclosing any part of a graphic-object selects the whole thing.

To set selection methods for the selection tools:

1. From the Flash menu (Mac) or the Edit menu (Windows), choose Preferences.
   The Preferences dialog appears.
2. From the Category list, choose General.
3. In the Selection section, select either of the following checkboxes:
   Shift Select. In Shift Select mode (Flash’s default setting), you must Shift-click to add items to the current selection. With Shift Select turned off, each new item you click with the selection tool is added to the current selection.
   Contact-Sensitive Selection and Lasso Tools. With Contact-Sensitive Selection on (the default), when a selection outline touches a graphic-object or text field, a grouped shape, or a symbol instance, Flash selects the whole thing. When Contact-Sensitive Selection is off, the selection outline must fully enclose the item to select it. This setting has no effect on merge-shapes.
4. Click OK.
Making Selections

Merge-shapes, drawing-objects, and primitives all behave slightly differently when being selected. What you think of as a single shape may contain several segments. The rectangle tool creates a square whose stroke is actually four separate line segments. Clicking one side of a merge-shape square’s stroke selects just that segment. To fully select the square’s stroke, you must select each segment (you could use Shift-click to add the remaining sides to the initial selection). If you create the square as a drawing-object or a rectangle-primitive, Flash treats the four stroke segments as a unit. Clicking the stroke on any side of a drawing-object square or rectangle-primitive selects the entire stroke.

Flash highlights selected areas of merge-shapes with a pattern of tiny dots. Make sure all the parts of the merge-shape stroke or fill you intend to select display this pattern.

To make selections by clicking:

1. In the Tools panel, choose the selection tool, or press V on the keyboard.

2. To select elements created as merge-shapes, do one of the following:
   - To select a merge-shape fill, position the pointer over the fill and click. The selection icon appears next to the pointer, indicating that the tool is ready to move or select an item. Click a fill to select it. A dot pattern in a contrasting color highlights the selected fill.
   - As you prepare to select a line, additions to the pointer icon indicate what kind of point lies beneath the pointer.

Double-Click Tricks

Double-clicking any segment in a series of connected merge-shape strokes selects all the segments. Double-clicking the fill of a merge-shape that has a fill and a stroke selects the fill and the stroke together.
These modifier icons indicate that the tool is over a point in a line segment and show what type of point it is: a curve point or a corner point. (For more information about points, see the side-bar “About Curve and Corner Points,” later in this chapter). Flash highlights just the segment you clicked, using a dot pattern  

3. To select elements created as drawing-objects, position the pointer over any portion of the shape and click. The arc or angle modifier icon appears next to the selection pointer as described above for merge-shape fills and strokes. Flash selects the entire shape and highlights it by displaying the bounding box—a rectangle that encloses the shape  

4. To select elements created as primitives, position the pointer over any portion of the shape and click. The selection icon appears next to the selection pointer whether it’s over a fill or a stroke. Flash selects the entire shape and highlights its bounding box  

When you click a merge-shape line, Flash selects and highlights just one segment. 

When you position the selection tool over an unselected drawing-object (left), the pointer displays the same modifier icons as for merge-shapes (move/select cross for fills, curve-point arc or corner-point angle for strokes). Click anywhere on the drawing-object, and Flash selects the entire drawing-object, highlighting its bounding box (right). 

Whether you position the selection pointer over the stroke (top) or fill (middle) of a primitive-shape, the selection icon appears by the pointer. Clicking anywhere on the shape selects the whole thing (bottom).
5. To add elements to a selection, do one of the following:
   - With Shift Select (Flash’s default selection style) active, hold down the Shift key as you click each item you want to add.
   - If you turned off the Shift Select option in the General category of the Preferences dialog, click each item you want to include.

Flash highlights each new item and adds it to the selection.

**Tip** To switch to the selection tool temporarily while using another tool, press Command (Mac) or Ctrl (Windows). The selection tool remains in effect as long as you hold down the modifier key.

**Tip** To select everything that’s currently on the Stage, choose Edit > Select All, or press Command-A (Mac) or Ctrl-A (Windows).

**Tip** The bounding box for a round or irregular drawing-object or primitive-shape is easy to see because the box sits outside the shape like a frame, and the bounding box for a rectangle-primitive has control points that make it more visible; but the bounding box for a drawing-object rectangle sits right on the edge of the rectangle. Therefore, depending on the color of your drawing-object rectangle, the highlighted bounding box can be difficult to see. If you have trouble seeing the highlight on selected drawing-object rectangles, choose a contrasting highlight color in the General category of the Preferences dialog.
To use a contact-sensitive selection rectangle:

1. Make sure the selection preferences are set for contact sensitivity (see “Setting Selection Preferences,” earlier in this chapter).

2. In the Tools panel, select the selection tool.

3. Click and drag to pull out a selection rectangle. This rectangle isn’t a graphic element; it just defines the boundaries of your selection.

4. Continue dragging until the rectangle encloses all the merge-shapes you want to select and at least some part of each drawing-object.

5. Release the mouse button.

**Merge-shapes.** Flash highlights any portions of fill or stroke that fall inside the selection rectangle; portions of merge-shape fills or strokes that lie outside the rectangle remain unselected.

**Drawing-objects and primitive-shapes.** If the selection rectangle touches any part of a drawing-object or primitive, Flash selects the entire thing, highlighting its bounding box.

**When Flash’s default contact-sensitive selection mode is active, any drawing-objects or primitives that are touched or partially enclosed by the selection rectangle are fully selected. But when it comes to merge-shapes, only the parts that fall within the selection rectangle are selected. (Here the star shapes are drawing-objects, the indented rectangles are primitives, and the circles are merge-shapes.)**
To use a non-contact-sensitive selection rectangle:

1. Make sure contact sensitivity is turned off (see “Setting Selection Preferences,” earlier in this chapter).

2. Follow Steps 2–5 in the preceding exercise, but this time, fully enclose the drawing-objects you want to select.

**Merge-shapes.** Flash highlights any portions of fill or stroke that fall inside the selection rectangle; portions of merge-shape fills or strokes that lie outside the rectangle remain unselected.

**Drawing-objects and primitive-shapes.** Flash selects only those drawing-objects or primitives that are completely enclosed within the selection rectangle. If the selection rectangle touches or includes just a part of a drawing-object or primitive, Flash leaves the entire object deselected.

---

**TIP** If the lines or shapes you want to select are located close to other lines, you may have difficulty selecting just what you want with a rectangle. The lasso tool can create an irregular selection outline. In the Tools panel, select the lasso tool, or press L. Click and draw a free-form line around the elements you want to select. Close the selection outline by bringing the lasso pointer back over the spot where you began the selection outline. Release the mouse button. Flash highlights whatever falls inside the shape you drew with the lasso.

---

*The lasso tool lets you select elements that are oddly shaped or too near other elements to allow use of the selection rectangle. Any merge-shapes inside the selection outline become highlighted and selected when you release the mouse button. Whether or not you must fully enclose drawing-objects and primitives in a lasso selection outline to select them depends on the contact-sensitivity setting in the Preferences dialog.*

---

*When contact-sensitivity is inactive, a selection includes just the parts of merge-shapes that fall within the selection rectangle. For drawing-objects or primitives to be selected, they must be fully enclosed by the selection rectangle. (Here the star shapes are drawing-objects, the indented rectangles are primitives, and the circles are merge-shapes.)*
The lasso’s Polygon mode lets you define a selection area with a series of connected straight-line segments. With the lasso tool selected, click the Polygon Mode button in the Tools panel. Now you can click your way around the elements you want to select. Double-click to end the selection outline.

To deselect individual items:

1. In the Tools panel, select the selection tool.
2. Hold down the Shift key.
3. Click any highlighted drawing-objects, primitives, or merge-shape strokes or fills you want to remove from the current selection.

Flash deselects the items you clicked. No matter which method you used to select items, you must Shift-click with the selection tool to remove items from a selection.

To deselect everything, choose Edit > Deselect All, or press Shift-Command-A (Mac) or Ctrl-Shift-A (Windows).

To deselect all elements quickly, click the selection tool in an empty area of the Stage or Pasteboard.

With the selection tool selected, position the pointer over the element you want to remove from the selection (left). Shift-click the item to deselect it (middle). Repeat the process to deselect another item (right). (In this image, the stars are drawing-objects, and the circles are merge-shapes.)
Resizing Graphic Elements

Flash gives you several ways to resize, or scale, graphic elements. You can scale selected elements interactively on the Stage. You can also set specific scale percentages or dimensions for your element in the Transform panel, the Position and Size section of the Property inspector, and the Info panel.

To resize a graphic element interactively:

1. In the Tools panel, from the transform-tools submenu, select the free-transform tool or press Q A.
2. On the Stage, click the element you want to resize.
   Flash selects and highlights the element and places transformation handles on all four sides and at the corners of the element’s bounding box.
3. In the Tools panel, select the Scale modifier.
4. Position the pointer over a handle.
   The pointer changes to a double-headed arrow, indicating the direction in which the element will grow or shrink as you drag the handles inward or outward.
5. To resize the graphic element, do one of the following:
   - To change the graphic element’s width, click and drag one of the side handles.
   - To change the element’s height, click and drag the top or bottom handle.
   - To change the size of the element proportionally, click and drag one of the corner handles.
   
   Dragging toward the center of the element reduces it; dragging away enlarges it B. 

A The free-transform tool lets you select and scale elements interactively.

B Activating the free-transform tool’s Scale modifier places a set of handles around a selected element. Click and drag the handles to change the size of the element.
In the default scaling mode, the selection scales graphic elements from the control point opposite the one you’re dragging. To scale relative to the center of a selection, hold down the Option key (Mac) or Alt key (Windows) as you drag. For symbols (see Chapter 7), it’s the reverse: the default mode scales the symbol from its transformation point (which is the center by default), and pressing the Option key (Mac) or Alt key (Windows) lets you scale from the opposite control point.

To resize an element via the Transform panel:

1. With the Transform panel open, on the Stage select the element you want to resize.

   Percentages appear in the Scale Width and Scale Height hot text in the top section of the Transform panel. When you select an element that’s never been resized, width and height are set to 100%.

2. To resize the element without changing its aspect ratio (the ratio of width to height), do the following:
   - In the top section of the Transform panel, set the Constrain/Unconstrain modifier to Constrain mode (the closed-link icon). Clicking the icon toggles between Constrain and Unconstrain modes.
   - Use the Scale Width (or Scale Height) hot text to enter a new percentage.

   To use a precise value, click the hot text, enter a number in the field that activates, then press Enter. To choose a value interactively, position the pointer over the hot text; when the pointing finger with a double arrow appears, drag left (or down) to lower the value or drag right (or up) to increase the value. Flash previews the changes on the Stage as you drag the hot text’s invisible slider.
In Constrain mode, changing the Scale Width percentage also changes the Scale Height percentage (and vice versa).

or

To resize the element and allow the aspect ratio to change, do the following:

- Set the Constrain/Unconstrain modifier to Unconstrain mode (the broken-link icon).
- Use the Scale Width and Scale Height hot text to enter new percentages.

In Unconstrain mode, entering new values for Scale Width and Scale Height changes those dimensions of the selected element independently.

**TIP** To undo changes you made to an element’s width and height (whether made using the free-transform tool or a panel setting), click the Reset button in the top section of the Transform panel or press Shift-Command-Z (Mac) or Ctrl-Shift-Z (Windows). For merge-shapes, you must not have deselected the transformed element; for drawing-objects, primitives, text fields (see Chapter 3), groups (see Chapter 5), and symbols (see Chapter 7), you can select the object and click the Reset button anytime to restore the item to its original 100% width and height.

**TIP** A Remove Transform button appears at the bottom-right corner of the Transform panel; that button undoes all the transformations you applied to the selected item, not just the width and height changes.

**TIP** To scale several elements at the same time, select all the elements and then use any of the scaling methods described earlier in this section. When you use the Transform panel, the bounding box that contains the elements scales relative to its center point, and the entire selection grows or shrinks to fit the new box. When you use the free-transform tool, the bounding box scales from the corner opposite to the one you’re dragging.

**TIP** Once you’ve gotten pleasing proportions for an element by adjusting its width and height independently, choose the Constrain mode to lock in the aspect ratio. Using the Scale Width or Scale Height hot text now scales the element while preserving the new aspect ratio.

**TIP** Flash resizes merge-shapes on an absolute scale as long as the shape remains selected. Deselect the shape, and the current width and height become the shape’s new 100%. To transform merge-shapes on a relative scale, select the shape and enter new values for Scale Width and/or Scale Height using the Transform panel, then deselect the shape. Select the shape again (Scale Width and Scale Height now show a value of 100%). Enter new percentages for the second transformation.

**TIP** Flash always resizes drawing-objects, primitives, text fields, groups, and symbols on an absolute scale (applying the percentage you enter into the panel to the element’s original size).
To resize an element via the Property inspector:

1. With the Property inspector open, in the workspace, select the element you want to resize.

   The Position and Size section of the Property inspector contains Width and Height hot text displaying the dimensions of the selected shape’s bounding box.

2. To resize the element, do either of the following:
   - To preserve the aspect ratio, set the Constrain/Unconstrain modifier to Constrain mode (the closed-link icon). Use the Width or Height hot text to enter a new value. Click the hot text to enter a precise value; drag the hot text’s invisible slider to choose a value interactively. Changing the value for one dimension automatically changes the other.
   - To allow the aspect ratio to change, set the Constrain/Unconstrain modifier to Unconstrain mode (the broken-link icon); use the Width and/or Height hot text to enter new values.

   The Width and Height hot text in the Position and Size section of the Property inspector displays the dimensions of the bounding box of a selected element. Enter new values to resize the element. In Constrain mode (the closed-link icon), Flash preserves the ratio of width to height. In Unconstrain mode (the broken-link icon), you can enter independent width and height values.

   You can enter precise dimensions for an element’s width and height in the Info panel. The Registration/Transformation Point model shows whether changes will be relative to the registration point (1) or to the transformation point (2). To apply the values you entered in the panel to the selected graphic element, press Enter or click the Stage.

   You can enter precise dimensions for an element’s width and height in the Info panel. The Registration/Transformation Point model shows whether changes will be relative to the registration point (1) or to the transformation point (2). To apply the values you entered in the panel to the selected graphic element, press Enter or click the Stage.

TIP The Info panel lets you resize a selected element relative to its registration point (the top-left corner of its bounding box) or transformation point. Click the Registration/Transformation Point model to toggle between modes. A crosshair in the upper-left corner of the model means the values are relative to the registration point; a circle in the model’s lower-right corner means the values are relative to the transformation point. Values in the Property inspector are always relative to the registration point. (For more details, see the sidebar “How Flash Tracks Elements,” later in this chapter.)
Positioning Graphic Elements

If you aren’t happy with the position of an element, you can always move it. You can position elements visually by dragging them around on the Stage with the selection tool. You can also position a selection numerically by specifying a precise Stage location in x- and y-coordinates. You can enter the x- and y-coordinates in either the Property inspector or the Info panel.

To reposition an element via the Property inspector:

1. With the Property inspector open, select an element on the Stage.

   A label—for example, Drawing Object—appears at the top of the Property inspector, identifying the type of element selected. The Position and Size section of the Property inspector displays the x- and y-coordinates of the element’s registration point.

2. To move the element, do one or both of the following:
   - To position the element along the horizontal axis, use the X hot text to enter a new x-coordinate.
   - To position the element along the vertical axis, use the Y hot text to enter a new y-coordinate.

   Click the hot text to enter a precise value; drag the hot text’s invisible slider to choose a value interactively. The element moves to its new position B.

   B Changing the x- and y-coordinates in the Position and Size section of the Property inspector changes the location of a selected element. This arrow is now located 1 inch to the right along the horizontal axis and 1 inch down the vertical axis.

   TIP By default, the transformation point corresponds to a point at the center of a shape’s bounding box. You can change that. With the free-transform tool, drag the hollow circle that represents the transformation point to a new location.
How Flash Tracks Elements

To keep track of an element’s size and position on the Stage, Flash encloses each element in a bounding box—an invisible rectangle just big enough to hold the element. Flash then treats the Stage as a giant graph, with the top-left corner of the Stage as the center of the x- and y-axis. The units of measure for the graph are those currently selected in the Document Settings dialog (to learn more about document properties, see Chapter 1). The Property inspector and the Info panel display information about the size of the element (the width and height of the bounding box) and the position of the element (the x- and y-coordinates for one important point in the element).

By entering new values for Height and Width in the Position and Size section of the Property inspector or in the Info panel, you can change an element’s size. By entering new x- and y-coordinates in those panels, you can change an element’s position on the Stage. (For more information about resizing elements, see “Resizing Graphic Elements,” earlier in this chapter.)

Depending on which panel you use to enter values for an element, you can use either of two points to position an element: the registration point or the transformation point. For merge-shapes, drawing-objects, and primitives, the registration point is always located at the top-left corner of an element’s bounding box. For symbols, you determine the location of registration point, which stays the same for all instances of the symbol. For all types of objects, Flash initially places the transformation point at the center of the bounding box; you can reposition it using the free-transform tool. You can position the transformation point differently for individual symbol instances (see Chapter 7).

The Property inspector always tracks elements by the registration point. The Info panel lets you track elements by either point. You choose the point by clicking the Registration/Transformation-Point model to toggle between the two tracking styles. When a crosshair appears in the top-left corner of the model, the Info panel settings position and size elements by the registration point. When a circle appears in the bottom-right corner of the model, the Info panel settings position and size elements by the transformation point.

When you use ActionScript to dynamically move symbol instances at runtime, Flash always uses the registration point to position them.
Flipping, Rotating, and Skewing

Flash lets you flip, rotate, and skew selected elements. You can either manipulate elements freely with the free-transform tool’s Rotate and Skew modifier or use a variety of commands to do the job with more precision.

To flip a graphic element:
1. Select the element you want to flip.
2. Choose Modify > Transform.
3. From the submenu A, choose either of the following:
   - To reorient the element so that it spins 180 degrees around its horizontal central axis like a Rolodex card file, choose Flip Vertical.
   - To reorient the element so that it spins 180 degrees around its vertical central axis like a weathervane, choose Flip Horizontal.

B shows the results of the two types of flipping.

Tip You can flip and scale selected elements simultaneously by using the free-transform tool in Scale mode. Drag one handle all the way across the transform box and past the handle on the other side. To flip a selected element vertically and horizontally, for example, drag the handle in the bottom-right corner diagonally upward, past the handle in the top-left corner C. The flipped element starts small and grows as you continue to drag away from the element’s top-left corner. Flash previews the flipped element; release the mouse button when the element is the size you want.
To rotate an element in 90-degree increments:

1. Select the element you want to rotate.
2. Choose Modify > Transform D.
3. From the submenu, choose either of the following:
   - To rotate the element clockwise 90 degrees, choose Rotate 90° CW.
   - To rotate the element counterclockwise 90 degrees, choose Rotate 90° CCW.

To rotate an element by a user-specified amount:

1. Select the element and access the Transform panel E.
   If the panel isn’t open, choose Window > Transform.
2. Select the Rotate radio button.
3. To specify the direction and amount of rotation, do either of the following:
   - To rotate the element counterclockwise, use the Rotate hot text to enter a negative value (–0.1 to –360).
   - To rotate the element clockwise, use the Rotate hot text to enter a positive value (0.1 to 360).
   Click the hot text to enter a precise value; drag the hot text’s invisible slider to choose a value interactively.

D To rotate a selected element in 90-degree increments, use the Modify > Transform menu. Repeat the command to rotate the element 180, 270, or 360 degrees.

E The Transform panel lets you rotate graphic elements in precise increments. Select the Rotate radio button and use the hot text to enter a value for the degrees of rotation. Positive values rotate the element clockwise; negative values rotate it counterclockwise.
When you work with drawing-objects and primitive-shapes, you can undo changes in width, height, rotation, and skewing at any time, even after you’ve deselected the item and made changes to other items. To restore the original Width, Height, Rotate, and Skew settings, select the item and click the Transform panel’s Remove Transform button.

For merge-shapes, the Reset and Remove Transform buttons work only as long as the shape remains selected.

To skew an element by a user-specified amount:

1. With the Transform panel open, select the element you want to skew.
2. In the Transform panel, select the Skew radio button.
3. Using the Skew Horizontal and Skew Vertical hot text, enter the desired skew values.

Click the hot text to enter a precise value; drag the hot text’s invisible slider to choose a value interactively.

You can quickly create step-and-repeat versions of a transformed object. Say you need three squares with the same dimensions, but with Horizontal Skew values of 10, 20, and 30 degrees. Create the original square, select it, and set the Horizontal Skew to 10 degrees in the Transform panel. With the square still selected, click the Duplicate Selection and Transform button. Flash duplicates the square with the 10-degree horizontal skew, then applies the current Horizontal Skew value to the already skewed square. The effect is to increase the Horizontal Skew value by 10 degrees with each duplication.
To rotate or skew an element interactively:

1. Select an element to rotate or skew.

2. In the Tools panel, select the free-transform tool; then click the Rotate and Skew modifier.

A transform box (similar to the element’s bounding box, but with square handles at the corners and on all four sides) encloses the element.

3. To modify the selected element, do either of the following:
   - To rotate the element, position the pointer over one of the corner handles.
     The pointer changes to a circular arrow. Click and drag to rotate the element. Flash spins the element around its transformation point.
   - To skew the element, position the pointer over one of the side handles of the transform box.
     The pointer changes to a two-way arrowhead. Click and drag the side handle to skew the element.

4. Release the mouse button.
   Flash redraws the modified element.

**Tip** To rotate an element around one of its corners instead of its transformation point, press Option (Mac) or Alt (Windows) while dragging.

**Tip** To constrain rotation by 45-degree increments, hold down the Shift key while rotating.
Distorting Graphic Elements

The free-transform tool’s Distort modifier lets you change the shape of the transform box. You can move a corner individually; move two corners simultaneously to turn the box into a trapezoid; and move the side handles to stretch, shrink, or skew the box. The selected element(s) redraw to fit the altered box. The Distort modifier works only on merge-shapes and single, selected drawing-objects; Distort doesn’t work on primitive-shapes, text fields (see Chapter 3), groups (see Chapter 5), symbols (see Chapter 7), or selections with multiple drawing-objects.

To distort an element freely:
1. Using the free-transform tool, select the element you want to distort.
   A transform box with handles appears.
2. In the Tools panel, select the Distort modifier A.
   The center point of the selection disappears, indicating that you are in Distort mode.
3. Position the pointer over one of the transform handles.
   The pointer changes to a hollow arrowhead.
4. To change the shape of the transform box, do one of the following:
   - To relocate one corner of the box, position the pointer over one of the corner handles; then click and drag the handle to the desired location. You can position each corner handle independently B.

continues on next page
To skew the element, position the pointer over one of the side handles; then drag the handle to the desired position. The element skews toward the direction you drag.

To stretch the element as you skew it, move the selected side handle away from the element’s center.

To shrink the element as you skew it, move the selected side handle toward the element’s center.

5. Release the mouse button.
Flash redraws the selection to fill the new transform-box shape.

When you select multiple drawing-objects, the free-transform tool’s Distort modifier is inactive. To distort multiple drawing-objects simultaneously, you must combine them into a single drawing-object (see “Converting Shape Types,” later in this chapter).

Adding Perspective

As beginning art students discover, it’s not difficult to add depth to two-dimensional objects made up of rectangular shapes. You adjust the appropriate edges to align with imaginary parallel lines that converge at a distant point on the horizon—the vanishing point. Doing so creates the illusion that the objects recede into the distance. Adding perspective to nonrectangular shapes takes a bit more experience and the ability to imagine the way those shapes should look. The Distort modifier of Flash’s free-transform tool helps you because it encloses your selected shape—circle, oval, or squiggle—within a rectangular transform box. All you need to do is adjust that box as you would a rectangular shape.

Flash CS5 also provides more-sophisticated tools for making two-dimensional objects appear to inhabit three-dimensional space. The 3D-rotation and 3D-translation tools work only on movie-clip symbols (you learn to create symbols in Chapter 7 and animated movie-clip symbols in Chapter 12). Flash’s 3D tools let you rotate and position movie clips not only along the x- and y-axis (for horizontal and vertical positions) but also along the z-axis (for depth), redrawing the object to make it appear to recede into space. The use of the 3D tools to create artwork that simulates three-dimensional environments is complex and is beyond the scope of this Visual Quickstart Guide. After you learn to create symbols, however, try using the 3D tools on a movie-clip symbol containing a simple shape, such as a square. Experimenting on this basic level gives you a feel for how the tools distort the “plane” that the movie clip resides in and create the 3D illusion.
To distort a graphic element symmetrically:

1. Follow Steps 1 and 2 of the preceding task to prepare an element for distorting.

2. To taper the element, do either of the following:
   - To make the top of the transform box narrower than the bottom, Shift-click and drag the top-right corner handle toward the top-left corner handle D, or vice versa.
   - To make the top of the transform box wider than the bottom, Shift-click and drag the top-right corner handle away from the top-left corner handle, or vice versa.

   As you drag, the two corner handles move in tandem, coming together if you drag in or moving apart if you drag out.

3. Release the mouse button.

Flash redraws the transform box and its contents. If you dragged in, the box appears to taper toward the top. If you dragged out, the box appears to taper toward the bottom. You can follow these procedures for the sides or bottom of the bounding box to taper the box in any direction.

To distort a graphic element nonsymmetrically:

1. Follow Steps 1 and 2 of the preceding task to prepare an element for distorting.

2. To taper the element, do either of the following:
   - To make the top of the transform box narrower than the bottom, Shift-click and drag the top-right corner handle toward the top-left corner handle D, or vice versa.
   - To make the top of the transform box wider than the bottom, Shift-click and drag the top-right corner handle away from the top-left corner handle, or vice versa.

   As you drag, the two corner handles move in tandem, coming together if you drag in or moving apart if you drag out.

3. Release the mouse button.

Flash redraws the transform box and its contents. If you dragged in, the box appears to taper toward the top. If you dragged out, the box appears to taper toward the bottom. You can follow these procedures for the sides or bottom of the bounding box to taper the box in any direction.

TIP The free-transform tool's Distort Modifier doesn't work on text fields, groups, and symbols. If your selection includes merge-shapes and one or more text fields, groups, or symbols, the free-transform tool's Distort modifier is available, but the distortion affects only the merge-shapes.

TIP You can use the free-transform tool to distort multiple merge-shapes simultaneously. Select the merge-shapes you want to modify. Then, using the Distort modifier of the free-transform tool, redefine the shape of the transform box that surrounds the shapes. The shapes change as a unit.

TIP When you select multiple merge-shapes, clicking one shape with the paint bucket changes all selected merge-shape fills. The ink-bottle tool works the same way on merge-shape strokes (see the task “To change stroke color with the ink-bottle tool,” in the next section). When you select multiple drawing-objects or primitive-shapes, however, these tools can't modify all the fills or strokes in the selection; you must click each fill and stroke individually, or use a panel to make the changes (see the sidebar “Use Panels to Change Selected Fills and Strokes,” later in this chapter.).

TIP When you've already selected an element with the free-transform tool, you can access the hollow-arrow pointer temporarily without selecting the Distort modifier; press Command (Mac) or Ctrl (Windows). Then you can drag or Shift-drag to distort selected elements.

TIP If you make a mistake while distorting a graphic, and you choose Edit > Undo so you can fix it, your graphic will be selected with the free-transform tool but the Distort modifier won't be active. You must reselect the Distort modifier in the Tools panel to continue your distortion.
Modifying Fills and Strokes

Flash provides two methods for modifying existing fills and strokes: you can apply new attributes with a tool (the paint-bucket tool for fills, the ink-bottle tool for strokes), or you can select the fill or stroke on the Stage and choose new attributes in an appropriate panel. For fills or strokes that contain a gradient, you can also modify the way the gradient fits in the shape by using the gradient-transform tool.

To change fill color with the paint-bucket tool:

1. In the Tools panel, click the active edit-fill/stroke tool and select the paint-bucket tool from the submenu, or press K.
2. Select new fill attributes (see Chapter 2).
3. Click the paint bucket’s hot spot (the tip of the drip of paint) somewhere inside the fill you want to change.

   The fill can be selected or deselected. The fill changes to the new color A.

TIP To pick up the color of a stroke or fill and use it for both strokes and fills, Shift-click with the eyedropper tool. Flash loads the selected color into the Fill Color and Stroke Color controls in the Tools panel, the Color panel, and the Property inspector.
Use Panels to Change Selected Fills and Strokes

You can modify the fill and stroke attributes of a selected graphic element by changing the settings in any appropriate panel. For example, draw an oval with a red fill and a solid, 1-point, blue stroke; then select the whole shape (note that if you create the oval as a drawing-object or primitive-shape, Flash automatically selects it). Now access the Fill and Stroke section of the Property inspector; it displays the attributes of the selected shape (or drawing-object or primitive). Select green from the Fill Color control; the oval fill changes to green. Increase the stroke height or choose a new stroke style; the oval stroke changes to match.

You can choose new colors for selected fills and strokes from any appropriate panel—Color, Swatches, or Tools—or the Property inspector. When you choose a new color from the Swatches panel, Flash uses the Color panel to determine whether that color is for fills or strokes. When the Fill Color control is selected in the Color panel, Flash applies the swatch color to selected fills; if the Stroke Color control is selected, Flash applies the color to strokes.

When a selected merge-shape has a stroke or fill set to No Color, however, the only way to change that setting is to add a fill or stroke by using the paint-bucket or ink-bottle tool (see Chapter 2).

When your selected shape is a drawing-object or primitive-shape, changing the fill or stroke attributes in the Color panel, Tools panel, or Property inspector adds the missing element. Using panel settings to change the attributes of a drawing-object or primitive-shape whose fill or stroke was originally set to No Color causes Flash to add the missing element, whereas doing the same thing for a selected merge-shape has no effect.
To change stroke color with the ink-bottle tool:

1. In the Tools panel, click the active edit-fill/stroke tool and select the ink-bottle tool, or press S.
2. Select new stroke attributes (see Chapter 2).
3. Click the ink bottle’s hot spot (the tip of the drip of paint) in one of the following ways:
   - Click directly on the stroke.
   - If a shape has both stroke and fill, and both are deselected, click the fill.
   - If a shape has both stroke and fill, and both are selected, click the fill.
   - If a shape has both stroke and fill, and only the fill is selected, click the stroke.

   The stroke takes on its new attributes.

**Tip** To save time, you can copy the fill and stroke attributes of one element and apply them to another. In the Tools panel, select the eyedropper tool, or press I. The pointer changes to an eyedropper. To copy a fill color or gradient, position the eyedropper over a fill and click. To copy all of a stroke’s attributes, position the eyedropper over the stroke and click. Flash switches tools; the paint bucket appears for fills, the ink bottle for strokes. The attributes of the clicked item appear in all related panels; when you click a fill, for example, the fill type and fill color appear in the Tools panel, the Color panel, and the Property inspector. You can then use the loaded paintbucket or ink-bottle tool to apply the attributes to a different graphic element.

### For merge-shapes, drawing-objects, primitives

- ![With nothing selected, click stroke or fill](image)
  - With nothing selected, click stroke or fill

- ![With fill and stroke selected, click stroke or fill](image)
  - With fill and stroke selected, click stroke or fill

### For merge-shapes only

- ![With just fill selected, click stroke](image)
  - With just fill selected, click stroke

- ![With part of stroke selected, click selection](image)
  - With part of stroke selected, click selection

**Warning:** Clicking a selected fill with unselected stroke does nothing

- ![You don’t have to select a stroke to change its attributes; just click the stroke or the unselected fill with the ink bottle. Warning: If the fill is selected, you must click the stroke itself; you can’t click the selected fill to change an unselected stroke.](image)
To change a gradient fill’s center point:

1. In the Tools panel, from the transform-tools submenu, select the gradient-transform tool, or press F D.

2. Position the pointer over the graphic element whose gradient you want to modify; the gradient can be located in a fill or in a stroke.

   The pointer changes to the gradient-transform pointer.

3. Click.

   Handles for manipulating the gradient appear E. You can rotate the gradient or change its size and/or center point.

4. Position the pointer over the gradient’s center-point handle, the circle icon.

   The move pointer appears.

5. Drag the center-point handle to reposition the center point of the gradient F.

**TIP** When you create a graphic element containing a locked gradient, by default Flash positions the gradient so that its center aligns with the left-hand side of the Stage. With the Stage set to larger viewing magnifications, when you select such an element with the gradient-transform tool, all of the gradient-transform handles may be outside the viewing area of your computer screen. It can seem as if the gradient-transform tool doesn’t work. If you click a gradient with the gradient-transform tool and nothing seems to happen, try choosing a new magnification level. Depending on your workspace setup, you may need to view the Stage at 50%—or even 25%—to see all the gradient-transform handles for a selected gradient.
To change a radial gradient’s focal point:

1. Follow Steps 1–3 in the preceding task.
2. Position the gradient-transform pointer over the focal-point handle, the triangle.
   The pointer changes to a triangle.
3. Click and drag the focal-point handle to a new location.
   The focal point, where you have the most concentrated amount of the gradient’s central color, shifts to the new location.

To resize a gradient in a fill or stroke:

1. With the gradient-transform tool selected in the Tools panel, click the graphic element that contains the gradient you want to modify.
2. To change the way the gradient fits inside the fill or stroke, do one of the following:
   ▶ To change the width of a linear gradient, drag the square handle.
      The pointer changes to a double-headed arrow. Dragging toward the center of your shape squeezes the transition into a narrower space; dragging away from the center of your shape spreads the transition over a wider space.
To change the shape of a radial gradient, drag the square handle I. The pointer changes to a double-headed arrow. Dragging toward the center of your shape creates a narrower oval space for the transition; dragging away from the center of your shape creates a wider oval space.

To change the radius of a radial gradient, drag the circular handle next to the square handle J. The pointer changes to an arrow within a circle. Dragging toward the center of your shape squeezes the transition into a smaller circular space; dragging away from the center of your shape spreads the transition over a larger circular space.

With a radial gradient selected, use the gradient-transform tool to drag the square handle inward to create a narrower oval for a gradient.

With a radial gradient selected, drag the first round handle outward to create a larger radius.
To control overflow:

1. Follow the steps in the preceding task
to create a gradient that is narrower
than the shape it sits in.
2. In the Color panel, in the Flow
section K, do one of the following:
   - To extend the colors in the leftmost
     and rightmost gradient pointers, select
     Extend Color (the button on the left).
   - To repeat the gradient, but with the
     colors in reverse order, select Reflect
     Color (the center button).
   - To repeat the gradient with colors in
     the original order, select Repeat Color
     (the button on the right).

Note that to activate the Flow buttons,
your Publish Settings must be set
to publish for Flash Player 8 or later
(see Chapter 18).

To rotate a gradient fill:

1. With the gradient-transform tool
   selected in the Tools panel, click the
   fill or stroke containing the gradient
   you want to modify.
2. To rotate the gradient, do either of the
   following:
   - To rotate a linear gradient, drag the
     round handle L.
   - To rotate a radial gradient, drag the
     round handle farthest from the square
     handle.

The pointer changes to a circular arrow.
You can rotate the gradient clockwise
or counterclockwise.

TIP Click and drag with the paint-bucket tool
to rotate the gradient as you apply it. To con-
strain the gradient angle to vertical, horizontal,
or 45-degree angles, hold down the Shift key
as you drag.
Modifying Simple Graphics

Modifying Shapes: Natural Drawing Tools

All the strokes and fills you create in Flash can be edited after you’ve drawn them. You can edit merge-shapes and drawing-objects in Flash’s natural-drawing style, using the selection tool to change the path that defines the shape, or you can work directly with the path’s anchor points and Bézier curves by using the subselection, pen, and anchor-point tools (see “Modifying Shapes: Bézier Tools,” later in this chapter). You can modify primitive-shapes by manipulating their control points with the selection tool, or you can change their properties in the Property inspector.

When you use the selection tool, the merge-shape or drawing-object you want to modify must be deselected. If the element is selected, the selection tool moves the element as a unit. Always note what kind of modifier icon the selection pointer is displaying as it hovers over the path you want to modify.

For the following tasks, make sure the item you want to modify is deselected. These tasks all deal with modifying strokes, but the same techniques work for modifying fills by reshaping their paths (see the sidebar “The Mystery of Fill Paths,” later in this chapter).

About Curve and Corner Points

Flash’s selection and subselection tools let you modify an element’s curves and lines. The subselection tool lets you do so by moving the curve and corner points that define the element’s path and by rearranging the curves’ Bézier handles. When you drag a selection rectangle to enclose a merge-shape path with the subselection tool, Flash reveals any curve points’ Bézier handles. (Corner points have no handles.)

When you use the selection tool, Flash hides all that technical stuff. You simply pull on a line to reshape it. Still, the selection tool has its own hidden version of curve and corner points, which are evident only in the modifier icons that accompany the tool as it interacts with an unselected line or curve.

The modifier icons appearing with the selection pointer indicate what lies beneath the pointer.

The selection tool has its own hidden version of curve and corner points, which are evident only in the modifier icons that accompany the tool as it interacts with an unselected line or curve. When you tug on a curve point with the selection tool, you pull out a range of points in a tiny arc. When you tug on a corner point with the selection tool, you pull out a sharp point.

For the selection tool, corner points appear at the end of an unselected segment or at the point where two segments join to form a sharp angle. All those other in-between points—even those in the middle of a completely flat line segment—are curve points.

Over an empty spot
Over a selected line on the Stage
Over an unselected curve point
Over an unselected corner point

A The modifier icons appearing with the selection pointer indicate what lies beneath the pointer.
To activate the end of a segment with the selection tool:

1. Position the pointer over the end point of a deselected line segment.
   The corner-point modifier icon appears.
2. Click the end point.
   The end of the segment becomes active.
3. Reposition the end point in any of the following ways:
   - Drag away from the existing line or curve to lengthen the segment.
   - Drag toward the existing line or curve to shorten the segment.
   - Drag at an angle to the original line to pivot a straight-line segment to a new position or reshape the end of a curve segment.
   As you drag, the end of the line changes to a small circle, showing that the line is active for modifications; Flash previews the modified segment as you drag.
4. Release the mouse button.
   Flash redraws the line segment.

To reshape a curve with the selection tool:

1. Position the selection tool's pointer over the middle of an unselected curve segment.
   The curve-point modifier icon appears.
2. Click and drag the curve to reshape it.
   Flash previews the curve you’re drawing.
3. Release the mouse button.
   Flash redraws the curve.
To turn a straight-line segment into a curve segment with the selection tool:

1. Position the selection tool’s pointer over the middle of an unselected line segment. The curve-point modifier icon (an arc) appears.
2. Click and drag the line to reshape it. Flash previews the curve that you’re drawing.
3. Release the mouse button. Flash redraws the line, giving it the curve you defined.

To create a new corner point with the selection tool:

1. Position the selection tool’s pointer over the middle of an unselected line or curve segment. The curve-point modifier icon (an arc) appears.
2. Option-click (Mac) or Alt- or Ctrl-click (Windows). After a brief pause, the arc changes to the corner-point modifier icon (a right angle), and a circle appears where the pointer intersects the line. You’re now activating a corner point.
3. Drag to modify the line or curve segment and add a new corner point.

Although this line doesn’t look curved (top), Flash considers all its middle points to be curve points. Drag one of those points to create a line that looks like a curve (bottom). Option-click (Mac) or Alt- or Ctrl-click (Windows) to create a new corner point for editing your line. Dragging a corner point from a straight-line segment creates a sharp V (top). Dragging a corner point from a curve creates a V with curving sides that comes to a sharp point (bottom).
Modifying Shapes: Bézier Tools

The subselection tool lets you see and manipulate the anchor points of a path. You can reposition anchor points to change the path, and you can manipulate a point’s Bézier handles to modify the slope and depth of the curve. You can add and delete points and convert existing curve points to corner points, or vice versa, with the three anchor-point tools or the pen tool. Flash has two styles for displaying anchor points: hollow (the default) and solid. To pick a style, from the Flash menu (Mac) or the Edit menu (Windows), choose Preferences. In the dialog that appears, from the Category list, choose Drawing. In the Pen Tool section, select/deselect the Show Solid Points checkbox; click OK.

The tasks in this book assume that Show Solid Points is active.

To view a path and anchor points:

1. In the Tools panel, choose the subselection tool or press A.
   The pointer changes to a hollow arrow.

2. On the Stage, click the line or curve you want to modify.
   Flash selects and highlights the path and anchor points. To manipulate a particular point, you must select it directly.

**Tip** When the subselection tool is selected in the Tools panel, the Select All command—Command-A (Mac) or Ctrl-A (Windows)—highlights the path and anchor points for all the graphic elements on the Stage and Pasteboard.

The Mystery of Fill Paths

Although a fill shape without a stroke has no outline, it does have a path that defines its shape. The selection, pen, and subselection tools all work to reshape fill paths just as they do to reshape strokes, as outlined in the tasks in this chapter.

When you position the pointer over the edge of a fill shape, the selection tool displays either the curve-point or corner-point modifier icon. Clicking the edge of the fill activates a portion of the path outlining the shape (top). Selecting the edge of a fill shape with the subselection tool highlights the full path and its anchor points. You can reposition anchor points and Bézier handles to modify the fill shapes (bottom).
To select an anchor point:
1. In the Tools panel, select the subselection tool.
2. Move the subselection pointer over the path you want to modify.
   A small solid square appears next to the hollow arrow when the pointer is above a curve or line segment; a small hollow square appears next to the hollow arrow when the pointer is directly above an anchor point.
3. Click an anchor point.
   Flash highlights the selected point and displays its Bézier handles.

Tip: You can select multiple points on a merge-shape path directly with the subselection tool. Draw a selection rectangle that includes the points you want to select. Flash highlights the entire path and selects any points that fall within the rectangle. This technique won’t work on paths created as drawing-objects.

To move a corner point:
1. Use the subselection tool to highlight the path and anchor points of the element you want to modify.
2. Position the pointer over a corner point.
3. Click and drag the desired corner point to a new location.
   Flash redraws the path.

Tip: Corner points are often easy to identify without highlighting the path. You can click and drag such points directly without first highlighting the path. If you don’t click right on the point, however, you’ll move the whole path, not just the intended point.
To move a curve point:

1. Use the subselection tool to highlight the path and anchor points of the element.
2. Position the pointer over a curve point. The anchor-point modifier icon appears.
3. Click and drag the point to a new location. Flash previews the new curve as you drag.

After you move a curve point, the path remains selected, and the Bézier control handles become active so that you can further manipulate the curve.

To reshape a curve with the Bézier handles:

1. With the subselection tool, click the curve you want to modify.
2. Click one of the anchor points that define the curve you want to modify. Bézier handles appear.
3. Click and drag one of the Bézier handles.

The pointer changes to a solid arrow-head as you drag.

When you select an anchor point (1), Flash highlights the entire path (2). You can drag the anchor point to modify the path (3). The path and anchor points remain highlighted when you’re done (4).
4. To modify the curve, do one or more of the following:

- To make the curve bulge in the opposite direction, move the Bézier handle past the existing curve, in the opposite direction from the current bulge.
- To make the curve deeper, position the Bézier handle farther from the anchor point.
- To make the curve shallower, position the Bézier handle closer to the anchor point.

Flash previews the new curve as you manipulate the Bézier handle.

Tip A curve point that connects two curve segments has two Bézier handles. By default, the handles act in concert as you move them, modifying the curves on either side of the anchor point. You can adjust just one handle (one curve) at a time. Using the subselection tool, press Option (Mac) or Alt (Windows) while dragging the handle. Or, with the anchor point selected and the Bézier handles active, in the Tools panel select the convert–anchor-point tool. Use the caret pointer to drag a handle independently.

Tip For paths created in Merge Drawing mode, you can select an anchor point and activate its Bézier handles quickly. Use the subselection tool to draw a selection rectangle around the curve you want to modify. Flash highlights the path, selects the curves and the anchor points that fall within the selection, and activates their handles.

Tip You can move selected anchor points with the arrow keys. To move in larger increments, press the Shift-arrow key.

When you select anchor points, their Bézier handles appear. Leaning a Bézier handle away from a curve makes that curve segment more pronounced. Leaning the handle toward the curve flattens that part of the curve. Dragging the Bézier handle away from its anchor point makes the curve deeper; dragging the handle toward the anchor point makes the curve shallower.
The Mysterious Modes of the Pen Tool

Flash CS5 has three Bézier tools: add anchor point, delete anchor point, and convert anchor point. The pen tool can perform many of those functions. As you position the pen pointer over the Stage and existing paths, various modifier icons appear next to the pen icon, indicating the tool’s current function.

Create initial anchor point A small x indicates the pen is ready to place the first point in a path. Click any empty spot on the Stage to start your path.

Create sequential points The pen tool has no modifier icon when you are in the middle of placing a series of anchor points. Clicking the Stage adds points and segments to the path you are creating.

Add anchor point A plus sign appears when you position the pointer over a selected path, between anchor points. In this mode, double-clicking the path between two corner points adds a new corner point; double-clicking between two curve points (or between a curve and a corner point) adds a curve point. Single-clicking the path starts a new branching path; click away from the existing path to complete the first segment of the branch.

Convert curve point to corner point A caret appears when you position the pen pointer over a curve point in a selected path. Click the curve point and it changes to a corner point.

Delete corner point A minus sign appears when you position the pen pointer over a corner point in a selected path. Click the corner point and Flash removes it.

Extend path A slash appears when you position the pen pointer over a terminal anchor point (the first or last point in an open path). Clicking the point links the pen tool to that path; now clicking on the Stage creates a new point that extends the existing path.

Close path A circle modifier icon appears when you position the pen pointer over the initial anchor point of the path you are currently creating. (The circle also appears if you are using the pen tool to create a merge-shape path and you position the pointer over a terminal anchor point in a different merge-shape path.)

Join drawing-object path A chain-link modifier icon appears when you are creating a new path, and you position the pen pointer over one of the terminal anchor points in an existing drawing-object path.
To convert a corner point to a curve point:

1. Use the subselection tool to highlight the path and anchor points of the path you want to modify.
2. In the Tools panel, click the current Bézier tool and from the submenu that opens, choose Convert Anchor Point Tool.
   The pointer changes to an upward-pointing caret.
3. Position the caret pointer over a corner point.
4. To activate Bézier handles, click the point, then drag away.
   Flash converts the corner point to a curve point that has Bézier handles.
   As you drag, the handles extend and move, modifying the curve.

You can also use the subselection tool directly to convert a corner point to a curve point. Position the hollow-arrow pointer over a selected corner point, then Option-drag (Mac) or Alt-drag (Windows) away from the point to pull out the Bézier handles.

To switch between the Bézier and subselection tools quickly, use the keyboard shortcuts: press A for the subselection tool, P for the pen tool, = (equals sign) for the add–anchor-point tool, – (minus sign) for the delete–anchor-point tool, and C for the convert–anchor-point tool.
To convert a curve point to a corner point:

1. Using the subselection tool, select the path you want to modify.
2. In the Tools panel, from the Bézier-tools submenu, select the convert–anchor-point tool.
3. Position the caret pointer over a curve point.
4. Click the curve point.
   Flash converts the curve point to a corner point, removing the Bézier handles and flattening the curved path J.

**Tip** When using the pen tool, you can access the convert–anchor-point tool temporarily by holding down the Option (Mac) or Alt (Windows) key.

To delete an anchor point:

1. Using the subselection tool, select the path you want to modify.
2. In the Tools panel, click the current Bézier tool, and from the submenu that opens, choose the delete–anchor-point tool.
   The pointer changes to a pen icon with a remove-point modifier icon (a minus sign).
3. Position the pointer over an anchor point and click.
   Flash removes the anchor point and reshapes the path to connect the remaining points K.

**Tip** To access the delete–anchor-point tool temporarily while using the add–anchor-point tool, hold down the Option key (Mac) or Alt key (Windows).

**Tip** While you can also delete anchor points by selecting them with the subselection tool and pressing Backspace or Delete, the results may surprise you. If the selected anchor point connects two segments, pressing Delete removes the anchor point and reshapes the path. If the anchor point lies at the intersection of three or more segments, however, Flash removes not only the anchor point, but also all the line and curve segments that directly attach to the point. You may wind up removing more than you bargained for.
To add a point within a path:

1. Use the subselection tool to select the path you want to modify.

2. In the Tools panel, from the Bézier-tool menu, select the add–anchor-point tool. The pointer changes to a pen with a plus-sign modifier icon.

3. Position the pointer over the path and do any of the following:
   - Click between two corner points to create a new corner point.
   - Click between two curve points to create a new curve point.
   - Click between a corner point and a curve point to create a new curve point.

   Flash adds a new point.

To extend an existing path:

1. In the Tools panel, from the Bézier-tool submenu, select the pen tool.

2. Position the pointer over the anchor point at either end of the path (a terminal anchor point). The continue-path modifier icon—a small slash—appears next to the pen icon.

3. Click the terminal anchor point. The pen links to that point as if you’d just placed it.

4. Click to add points as you learned to do in Chapter 2.

   Note that to create a single unified path, the pen tool and the existing path must be in the same drawing mode. If the existing path is a drawing-object and the pen is set to Merge Drawing mode (or vice versa), Flash places the points, but the segments remain separate.
Modifying Primitive-Shape Paths

Flash's rectangle- and oval-primitive tools create shapes whose paths are defined by a set of properties specific to that shape. You can’t change the outline of a primitive-shape freely the way you can reshape the outline of a merge-shape or drawing-object. You can change the primitive’s defining properties by dragging control points in the shape or by setting new values for those properties in the Property inspector.

To change a rectangle-primitive’s properties interactively:

1. Using the selection tool, on the Stage select the rectangle-primitive you want to modify.

   The shape’s bounding box highlights, and control points appear A. Each corner has two control points. For sharp corners with a corner-radius setting of 0, the points sit directly on top of one another; for rounded corners, a control point appears at either end of the arc that defines the corner. The two points work in concert; dragging one moves the other.

2. Position the pointer over one of the control points.

   The pointer changes to a solid arrowhead.

3. To modify the shape, do one of the following:

   - To increase the radius (make the corner more rounded), drag the point inward.
   - To decrease the radius (make the corner less rounded), drag the point outward.

A The rectangle-primitive has two control points for the corner radius of each corner. When the corner radius is set to 0, the corner is a sharp 90-degree angle, and the control points sit directly on top of one another.

B As the corner radius increases, two control points appear at the end of the arc defining the corner. Drag inward to round the corner more, outward to round it less.
You can drag diagonally toward (or away from) the center of a shape, or you can drag vertically or horizontally toward (or away from) the center of the edge containing the control point B.

**TIP** By default, Flash constrains the corner-radius settings so that all four corners of a rectangle-primitive have the same degree of roundness. To create corners with various degrees of roundness, select the rectangle-primitive, access the Rectangle Options section of the Rectangle Primitive Property inspector, and click the Constrain Corner Radius modifier to change to the unlinked state (the open-link icon). You can then drag the control points for each corner independently, creating a variety of shapes C.

To change a rectangle-primitive’s properties precisely:

1. With the rectangle-primitive selected on the Stage, access the Rectangle Options section of the Rectangle Primitive Property inspector.
2. To modify the shape, in the Rectangle Corner Radius fields, do one of the following:
   - To create rounded corners, enter positive values.
   - To create indented corners, enter negative values.

For more details about setting the values of the various properties for rectangle-primitives, see Chapter 2.

**TIP** You can’t change a square or rounded corner to an indented corner by dragging the control points; you must set a negative value in the Property inspector. Once the rectangle-primitive has an indented corner, however, you can drag its control points to adjust the size of the indent D.

---

C With the Constrain Corner Radius modifier set to the unlinked state (open-link icon), you can enter values for each corner separately to create a variety of shapes.

D Dragging the control points of an indented corner (one with a corner radius value less than 0) changes the size of the indent. If you drag all the way back to a sharp corner, however, the control points revert to creating rounded corners as you drag. To get another indented corner, you must enter a negative value in the Property inspector.
To change an oval-primitive’s properties interactively:

1. Using the selection tool, on the Stage select the oval-primitive you want to modify.

   The shape’s bounding box highlights, and control points appear. Oval-primitives have four control points: one pair for the start and end angle of the outer oval and another pair for the start and end angle of the inner oval. When the start angle and end angle of an oval have the same value, the control points lie directly on top of one another.

2. Position the pointer over a control point.

   The pointer changes to a solid arrowhead.

3. To modify the shape, do any of the following:
   
   - To change the start angle, drag the control point clockwise or counterclockwise around the perimeter of the oval.
   
   - To change the end angle, drag the control point clockwise or counterclockwise around the perimeter of the oval.

   An oval-primitive has control points that control the start angle and end angle for the outer and inner oval shapes.

Drag the control points on the outer edge of an oval-primitive clockwise or counterclockwise to change the start and end angle of the shape.
To increase the inner radius (to create a larger space inside the oval), drag outward. To decrease the inner radius (to create a smaller space inside the oval), drag inward.

**Tip** Although you can use the subselection tool to select a primitive, doing so is a bit confusing and not recommended. When you click the shape, you won’t see a selection highlight or control points for the object, but the item is selected. Any changes you make to settings in the Property inspector after clicking on a primitive shape do modify that primitive.

### To change an oval-primitive’s properties precisely:

1. With the oval-primitive selected on the Stage, access the Oval Options section of the Oval Primitive Property inspector.
2. In the Start Angle, End Angle, or Inner Radius fields, enter new values.

For more details about setting the values of the various properties for oval-primitives, see Chapter 2.

**Tip** Although you can’t alter the paths of primitives to create fanciful free-form shapes, you can use a primitive as the starting point from which to create a shape whose paths can be modified freely. After you set the primitive’s properties, convert the shape to a merge-shape or drawing-object (see “Converting Shape Types,” later in this chapter). Then modify the merge-shape or drawing-object using any of the techniques discussed earlier in this chapter.
Using the Eraser Tool

Flash’s eraser tool imitates a real-world eraser—click and “scrub” to remove fills and/or strokes from merge-shapes and drawing-objects. The Eraser Mode menu in the Tools panel offers five modes for controlling what gets erased. In Erase Normal the eraser removes any line or fill you scrub over. In Erase Fills, the tool affects only fills. In Erase Lines, the tool affects only strokes. In Erase Selected Fills, the tool erases only from selected fills. In Erase Inside, the tool affects only the fill in which you begin erasing. These modes become important for working with graphics that have multiple elements (see Chapter 5).

Another eraser option is Faucet mode (click the Faucet modifier in the Tools panel, the faucet pointer appears). Clicking a deselected merge-shape or drawing-object stroke with the eraser in Faucet mode deletes all the segments that make up that stroke. In a selection containing multiple merge-shape strokes and/or fills, clicking any of the selected items with the faucet deletes the entire selection. In a selection containing multiple drawing-objects, however, the faucet deletes the individual fills or strokes you click, one at a time. Faucet is the only mode in which the eraser affects primitive-shapes, but it is a bit unreliable. Clicking the fill of a primitive shape with the faucet tool removes that fill; clicking the outside edge of a primitive-shape’s stroke usually has no effect; clicking the inside edge can result in deleting the entire object.

The eraser tool’s quickest trick is to clear the decks completely. Double-click the eraser tool in the Tools panel to delete the entire contents of the Stage.
Converting Shape Types

Flash offers a variety of shape types: fills, strokes, merge-shapes, drawing-objects, primitives, and text. It’s possible to convert some types of shapes into others. For example, you can convert strokes to fills; you can convert merge-shapes to drawing-objects and vice versa; you can convert primitive-shapes to merge-shapes and drawing-objects; and you can convert text, a special type of fill, to a regular drawing-object fill (for TLF text) or merge-shape fill (for Classic text). You cannot, however, convert merge-shapes or drawing-objects to primitive-shapes.

To convert a stroke to a fill:

1. Select a stroke on the Stage.
2. Choose Modify > Shape > Convert Lines to Fills.

Flash converts the stroke to a fill shape that looks exactly like the stroke. You can now edit the path of the “stroke’s” outline as though you were working with a fill created with the brush tool.

A To transform strokes into fills, choose Modify > Shape > Convert Lines to Fills.

B You can convert a stroke, such as this line drawn with the pencil tool (top), to a fill. The fill’s outline then has its own editable path (middle and bottom).
To convert a merge-shape or a primitive to a drawing-object:

1. Select a single merge-shape or primitive-shape on the Stage.
2. Choose Modify > Combine Objects > Union.

Flash converts the selected shape to a drawing-object; it remains selected.

TIP The Modify > Combine Shapes commands (Union, Intersect, Punch, and Crop) work on multiple, selected drawing-objects and primitives; the last three commands work on overlapping drawing-objects or primitives. In effect, these commands convert the drawing-objects or primitives to merge-shapes (so that they interact) and then convert the resulting shape(s) back into a drawing-object. Note that primitives lose their status as primitives once you combine them. You'll learn more about combining shapes in Chapter 5.

To convert a drawing-object or a primitive to a merge-shape:

1. Select a drawing-object or primitive-shape on the Stage.
2. Choose Modify > Break Apart, or press Command-B (Mac) or Ctrl-B (Windows).

Flash converts the selected drawing-object or primitive-shape to a merge-shape; it remains selected.

To convert a block of TLF text into individual drawing-objects:

1. Select a TLF text field on the Stage.

If the selected field links to other TLF text fields with threaded text, Flash selects all of the linked fields.

Select a single merge-shape or primitive-shape on the Stage.
Choose Modify > Combine Objects > Union.
Flash converts the selected shape to a drawing-object; it remains selected.

TIP The Modify > Combine Shapes commands (Union, Intersect, Punch, and Crop) work on multiple, selected drawing-objects and primitives; the last three commands work on overlapping drawing-objects or primitives. In effect, these commands convert the drawing-objects or primitives to merge-shapes (so that they interact) and then convert the resulting shape(s) back into a drawing-object. Note that primitives lose their status as primitives once you combine them. You'll learn more about combining shapes in Chapter 5.

To convert a drawing-object or a primitive to a merge-shape:

1. Select a drawing-object or primitive-shape on the Stage.
2. Choose Modify > Break Apart, or press Command-B (Mac) or Ctrl-B (Windows).

Flash converts the selected drawing-object or primitive-shape to a merge-shape; it remains selected.

To convert a block of TLF text into individual drawing-objects:

1. Select a TLF text field on the Stage.

If the selected field links to other TLF text fields with threaded text, Flash selects all of the linked fields.
2. Choose Modify > Break Apart. Flash transforms each letter in the selection into a drawing-object and selects it.

**Tip** Converting TLF text to drawing-objects can be useful if you have a small amount of text that you can’t (or don’t want to) supply to every end user, but you need to ensure the text looks exactly the same in the finished product as it did during the authoring phase.

**Tip** You don’t actually have to select a TLF text field; just position the text tool’s I-beam cursor anywhere within the text field. When you choose Modify > Break Apart, Flash converts all the text in that text field, and any fields linked to it, to drawing-objects.

---

**Breaking Down Classic Text**

The conversion process for Classic text works a bit differently than the process for TLF text. It takes two steps to transform Classic Text to simple graphic shapes. Classic-text characters convert to merge-shapes, while TLF-text characters convert to drawing-objects.

First, select the Classic text field on the Stage. Choose Modify > Break Apart. Flash places each letter in its own Classic text field and selects them all. Each Classic text field is just wide enough to hold one letter. Each letter is fully editable on its own, although the set of letters is no longer linked. Now, to transform those single-letter text fields into merge-shapes, with the text fields selected, choose Modify > Break Apart again. This second Break Apart command transforms the editable letters into raw shapes on the Stage. You can edit them as you would any other fill, but you can no longer change their text attributes with the text tool or Text (Tool) Property inspector.

---

With TLF text fields selected (top), choosing Modify > Break Apart transforms each letter into a separate drawing object (bottom).
Practice Session

Try converting a simple geometric shape into a more complex form. For example, try changing an oval fill into a flower shape.

- Use the oval tool to create a plump oval fill with no stroke A. (See Chapter 2, Making Geometric Shapes.)

Use the selection tool to add corner points to the oval’s path, then drag them inward to create petals B; use the selection tool to reposition the petals’ curve points to create a pleasing flower shape C. (See Natural Drawing.)

- Use the subselection and Bézier tools to add and remove points on the path of one petal to create a stem; adjust the curve of the stem using the stem points’ Bézier handles D, E. (See Modifying Shapes: Bézier Tools.)

Extra Credit: Modify the fill: use a linear gradient to give the flower a green stem and pink petals.

- Create a linear gradient fill that runs from dark green on the left, through hot pink, to pale pink on the right. (See Chapter 2, To create a linear gradient, Creating Solid Colors and Gradients.)

- Apply the gradient fill to your shape, then rotate the gradient so that green is on the bottom F. (See Modifying Fills and Strokes > To change fill color with the paint-bucket tool and > To rotate a gradient fill.)

Hint: Once you’ve got the fill inside the flower shape, adjust the position of the lower petals so that they fall completely into the “pink zone” of your gradient. You may also need to adjust the location of the gradient pointers in the Color panel to fit the “green zone” to the stem area of your shape.

Save your file for use in future Practice Sessions.
Index

{} (braces), 441, 447, 453  
[] (brackets), 441  
: (colon), 441, 453  
() (parentheses), 441  
; (semicolon), 441  
2D rotation, 320  
3D Brush pattern, 169  
3D rotation, 320  
3D tools, 124  
3D tweening, 320

A
absolute target paths, 477–478, 481  
Accessibility panel, 542  
Accessibility Resource Center, 542  
access privileges, 555, 556  
actions
  assigning to layers, 437  
  button, 442  
  choosing, 433  
  code hints for, 443  
  creating multiple, in event handler, 457–458  
  editing, 437  
  enclosing in braces, 441  
  previewing, 454–456  
  trace, 554  
ActionScript, 431–488
  allowing remote debugging of, 554  
  for animated symbols, 359  
  built-in classes, 450  
  for button components, 467–469  
  and components, 422  
  component skins, 425 (See also skins)
  for controlling movie playback, 437–440  
  for controlling sounds, 516  
  for controlling video playback, 531  
  events/event handlers, 451, 466  
  functions, 451, 453  
  and instance names, 450  
  keywords, 435
  for linking to other web pages, 482–486  
  for making buttons react to events, 463–465  
  for modifying/ending button scripts, 457–461  
  preferences, 2, 434–435  
  previewing scripts created with, 454–456  
  for programming buttons, 442–449  
  and Publish Settings dialog, 548  
  purpose of, 431, 455  
  for scripting movie clips to act as buttons, 472–476  
  scripting styles, 436  
  syntax, 441  
  and TLF SWZ files, 240  
  and TLF text, 549–550
  for using buttons to control Timelines, 477–480  
  for using event handler for multiple events, 470–471  
  using if statements in, 452  
  versions, 4, 359, 432, 548  
Actions panel, 432–435
  accessing, 432  
  buttons/controls, 433  
  customizing, 434–435  
  work areas in, 432  
Actions Toolbox, 432, 433  
add-anchor-point tool, 141, 142, 143  
Add Color menu, 321  
Add Keyframe command, 313  
Add Shape Hint command, 280  
adjustment layers, 494  
Adobe
  Accessibility Resource Center, 542  
  Community Help application, 28  
  Exchange, 422  
  Fireworks, 489  
  Flash Lite, 541  
  Flash Professional CS3, 218, 288  
  Flash Professional CS4 (See Flash CS4)  
  Flash Professional CS5 (See Flash CS5)  
  FreeHand, 489  
  Illustrator, 489, 491, 492  
  Media Encoder CS5, 499, 521  
  Photoshop, 489, 491, 492–497  
  Soundbooth, 500  
ADPCM compression, 551  
Advanced ActionScript 3.0 Settings dialog, 549, 550  
Advanced Character settings, 84, 98  
Advanced color-effect settings, 207  
AIFF format, 500  
AI File Importer preferences, 2  
alignment
  column, 101  
  paragraph, 95–96  
Align to Bottom button, 101  
Align to Top button, 101  
Alpha settings, 104, 206, 207. See also transparency  
AME, 499, 521  
Anchor Onion command, 245  
anchor points
  adding, 140  
  creating, 140  
  defined, 58  
  deleting, 142  
  selecting, 137  
  tools for working with, 133  
  viewing, 136  
animated 3D rotation, 320  
animated button symbols, 417–418  
animated GIF files, 492  
animated graphic symbols, 360–361  
animated movie-clip symbols, 362–363  
animated symbols, 359  
animated text fields, 92
animating
color effects, 268–269
FLVPlayback components, 533
human body, 359
on multiple layers, 339–350
animation, 215–372
adding keyframes to, 242–243
bouncing-ball (See bouncing-ball animation)
breaking into scenes, 334
with classic tweening, 249–270 (See also classic
tweening)
combining tweening and frame-by-frame, 355
complex, 333–372 (See also complex animation
tasks)
flip-book, 235
flying-bird, 270, 372, 408, 536
frame-by-frame, 215–248 (See also frame-by-
frame animation)
IK, 373, 377, 389 (See also inverse kinematics)
with motion tweening, 287–332 (See also motion
tweening)
Ping-Pong game, 339–348
previewing, 238–239
reducing repetitive work for, 369
reusable, 295
reversing, 351–356
saving as symbol, 357–359
smoothing, 237, 242–243
traditional, 215, 235
varying speed of, 242–243
Animation option, 92
animators, traditional, 215, 235
Animator workspace, 9
anti-aliasing, 87, 92
application frame, 1, 5, 8, 11
arcs, 300. See also curves
area-text fields, 71, 74–75, 76
armatures. See also bones
allowing x/y-translation of, 397–400
anatomy of, 378–379
author-time vs. runtime options for creating, 390
combining linear and branching, 381–383
connecting symbols with, 374–377
defined, 373
editing, 384
and instance naming, 379
manipulating to create poses, 386–387
removing entire, 407
removing individual bones from, 406
Arrange menu, 160
arrowhead icon, 78
artwork. See also graphics
accessibility considerations, 542
adding perspective to, 124
converting to symbols, 374
and IK bone tool, 374, 376
for movie-clip buttons, 426
using non-Flash, 489, 490
Asian text, 92
ASND format, 500
aspect ratio, 114, 116
assets
adding/removing, 462
defined, 193, 195
importing, 196, 490
locating specific, 194
reusable, 549
storing, 549
attributes
container, 98–103
fill, 40–42
line, 43
paragraph, 95–97
stroke, 43–45
text, 84–94
audio formats, 500. See also sounds
auditory feedback, 506–507
AU files, 500
authoring environment, 1, 8–10
author-time IK, 390
AutoCAD DXF files, 492
Auto Format preferences, 2
Auto Kern checkbox, 91
Automatic Close Brace option, 447
B
background color
for Flash documents, 16, 19
for text fields, 103, 104
for web pages, 561
ball animation. See bouncing-ball animation
Bandwidth Profiler, 538–541
banner ads, 6, 18
baselines, 99
Behavior menu, 99, 102
Behaviors, 516
Bevel join style, 44, 45
Bézier curves, 53, 105, 133, 322
Bézier handles, 58, 138–139
Bézier paths, 296, 322
Bézier tools, 136–143
bind tool, 401, 404–405
bird animation, 270, 372, 408, 536
bitmap-editing programs, 490
bitmaps
applying JPEG compression to, 548
editing, 490
exporting movies as, 537
importing, 490–491
and libraries, 195
bit rates, 552
Blank Keyframe command, 219, 220, 221, 222
blank keyframes, 216, 219–220, 221, 222
Blending menu, 213
blend modes, 213
blocking, 250
BMP files, 492
bones, 374–379
allowing x/y-translation of, 397–400
changing length of, 402
child, 376
constraining motion of, 388, 391–400
more vs. fewer, 383
moving, 388
parent, 375, 378
range-of-motion icons for, 396
removing, 406
repositioning, 401
sibling, 379
springy, 395
bonus materials, 489. See also companion website
borders, 103, 104
bouncing-ball animation
  with classic tweening, 251–255
  with frame-by-frame technique, 235–248
  with motion tweening, 288–293
  with shape tweening, 272–274
bounding box, 116, 117, 118
braces ({}), 441, 447, 453
brackets ([ ]), 441
branching armatures, 379
Break Apart command, 150–151, 189, 211, 407
break-link pointer, 82
Brick Pattern option, 167
Brightness settings, 205
Bring Forward command, 161
Bring to Front command, 161
broken tweens, 251
browsers. See web browsers
Brush Mode menu, 59
brush tool, 53, 58–60, 153
Building Brush pattern, 67, 169
bullet, hollow, 216
button actions, 442
button components, 419–425
  adding to movies, 467
  changing dimensions of, 421–422
  changing skins for, 425
  modifying labels for, 423
  placing instances of, 419–420
  previewing, 420
  scripting interactivity for, 468–469
  setting to act as toggle, 424
buttons. See also button components; button symbols
  adding sounds to, 506–507
  controlling sounds with, 516
  controlling Timelines with, 477–480
  creating consistent look for, 413
  creating states for, 411–412
  programming with frame scripts, 442–449
  reusing, 413
  rollover, 417–418
  scripting movie clips to act as, 472–476
button scripts, 457–461
button states
  for basic button symbols, 411–412
  with graphics, 415–416
  for movie-clip buttons, 426–429
  previewing, 413
  and touch screens, 413
button symbols, 410–418. See also buttons
  changing look of, 410
  characteristics of, 199, 409
  creating basic, 410–411
  creating fully animated, 417–418
  creating shape-changing, 415–416
  creating states for, 411–412
  as interactive objects, 466
  placing in movies, 413
  previewing, 414, 418
C
  candle flame, 349
cap styles, 43, 44
Case menu, 98
cel animation technique, 215, 235
Center button, 101
center point, 129
chain-link icon, 140
character animators, 361
character attributes, 84–94
Character settings, Text Edit mode, 84, 85
Check Syntax button, 454
child bones, 376
child object, 477
Chun, Russell, 320
classes, 436, 450
classic easing, 367
Classic text fields, 69, 70–71, 73, 82–83, 151
Classic text tool, 70
classic tweening, 249–270. See also tweening
  adding keyframes in, 256
  animating color effects in, 268–269
  applying, 254–255
  changing symbol transparency with, 269
  creating bouncing ball with, 251–255
  and custom easing, 367
  making symbols grow/shrink in, 263–264
  and motion guides, 260
  moving symbols along path in, 259–261
  moving symbols in straight line in, 257–258
  on multiple layers, 339–343
  and Orient to Path mode, 262
  practice session, 270
  preparing content for, 252–253
  re-creating, 369–371
  rotating/spinning symbols in, 265–267
  vs. motion tweening, 251, 287, 288
  vs. shape tweening, 273
  when to use, 250
classic tween symbols, 252
Classic workspace, 9
Clear Keyframe commands, 232, 233, 329
click event, 466
clicking, making selections by, 107–109
Clipboard, 2, 489
closed captioning, 542
closed chain-link icon, 82
closed paths, 140
Close Path check box, 52
code hints, 435, 443–444, 449, 450
Code Snippets panel, 431, 433, 462, 516
colon (:), 441, 453
color controls, 42, 91, 94, 104
color effects, animating, 268–269
color-effect settings, Advanced, 207
color models, 34, 35
Color panel, 33–38
Color Picker button, 42
colors
  adding to Swatches panel, 39
  defining new, 35
  hex coding for, 33
  saving, 39
colors (continued)
  setting transparency values for, 36
  for symbol instances, 204, 205
  for tween targets, 321
color sets, 39
column alignment buttons, 101
column gutters hot text, 102
columns hot text, 100
combine objects commands, 162–163
combine shapes commands, 150
combo box component, 467
column alignment buttons, 101
comment delimiters, 428, 429
common libraries, 196
companions website, this book's, 11, 73, 82, 194, 489
comparison operators, 452
compiled clips, 422
compiler errors panel, 454–455
compilers, 455
complex animation tasks, 333–372
  animating on multiple layers, 339–350
  manipulating frames in multiple layers, 335–338
  re-creating classic motion tweens, 369–371
  reversing animation, 351–356
  saving animations as symbols, 357–359
  using animated graphic symbols, 360–361
  using easing, 364–368
  using movie-clip symbols, 362–363
component assets folder, 425
component parameters section, property inspector,
  421, 422, 423–424, 530, 532
components
  and actionscript, 422
  creating your own, 422
  modifying behavior of, 419
  mystery of, 422
  previewing, 420
  purpose of, 422
  renaming, 420
  sources of, 422
component skins, 425
components panel, 419, 467
compression
  ADPCM, 551
  JPEG, 494, 548
  lossy, 494
  MP3, 552
  sound, 555
  speech, 552
  of SWF files, 552
  video, 522
compression pop-up menu, 494, 551
conditional statements, 446, 452
configuration folders, 7
connection speeds, 538, 541
constrain corner radius modifier, 145
constraining IK motion, 391–400
constrain/unconstrain modifier, 102, 114–115, 116, 319
contact-sensitive selection rectangles, 110
container and flow settings, 84, 85, 98–103, 104
container background color control, 42, 103
container border color control, 42, 103
containers, 71, 159, 216, 424
content path dialog, 530
controller window, 238
control menu, 238, 239
control points, 296, 297, 299, 301, 322
convert lines to fills command, 149
convert to blank keyframes command, 222
convert to symbol command, 197
convert to symbol dialog, 189, 199, 389
copy frames command, 228, 330, 337
copying and pasting
  frames, 228–229
  between layers, 182–184
  motion tweening, 330–331
  motion-tween spans, 330
  paths, 306
  property keyframes, 331
copy motion as actionscript 3.0 command, 369, 371
copy motion command, 369–370
copy pose command, 389
copy properties command, 331
corner-point icon, 107–108
corner points
  converting curve points to, 142
  converting to curve points, 141
  creating, 135
  deleting, 140
  moving, 133, 137
create new symbol dialog, 201
crop command, 163
cropping
  shapes, 163
  video images, 521, 545
crosshair, registration point, 116, 118
curly quotes, 100
curve-point icon, 107–108
curve points
  converting corner points to, 141
  converting to corner points, 140, 142
  modifying, 139
  moving, 133, 138
curves
  editing in motion editor, 322–323
  morphing shapes along, 285
  orienting tween target to, 303
  reshaping, 134, 138–139
  turning lines into, 135
custom classes, scripting with, 436
custom download settings dialog, 538
custom easing, 364, 367–368
customize tools panel command, 32
cutting and pasting, 182–184. See also copying and pasting
D
Damping value, 395
data-transfer rates, 538
debugging, remote, 558
debug workspace, 9
decorated brush pattern, 169
deco tool, 67, 164, 166–169, 170
decco tool property inspector, 166–169
delete-anchor-point tool, 142
descenders, 99
Designer workspace, 9
Developer workspace, 9
device fonts, 92, 93
diamond icon, 292, 302
DIB files, 492
digitally recorded sounds, 550
Disney, Walt, 215
distort modifier, 123–125
docking panels, 1, 11
document-level undo, 210
Document Property inspector
accessing Publish Settings dialog from, 544, 546
purpose of, 15, 16
setting frame rate in, 19, 241
shortcut to Document Setting dialog, 16
Stage color control, 19
SWF History section, 541
Document Settings dialog, 16–19
opening, 16
purpose of, 16
saving default settings in, 19
setting background color in, 19
setting frame rate in, 19, 241
setting size of Stage in, 17–18
dot pattern, 107, 164–166
dot syntax, 441
doubleClick event, 466
double-clicking, 107, 140, 159
double slash, 428
Down keyframe, 414
download-progress bar, 541
Down state, 412, 415–416
drawing
with pencil tool, 54
with pen tool, 55–57
drawing aids, 21, 53
Drawing Effect options, 164, 166, 169
drawing-object containers, 159
drawing-objects
changing fills/strokes for multiple, 125
combining multiple, 162–163
converting shape type, 150–151
converting TLF text into, 150–151
editing, on inactive layers, 180–181
modifying, 133, 159
removing part of another object with, 163
resizing, 115
selecting, 107, 108
and shape tweening, 273
undoing changes to, 121
vs. other types, 48
drawing preferences, 2, 53, 374
drawing tools, 29, 30, 53–62
Duplicate Symbol button, 213
Duplicate Symbol dialog, 206
DXF files, 492
Dynamic text, 70

E

easing, 364–368
applying to spans, 365–366
in classic tweening, 255
custom, 364, 367–368
in IK animation, 407
in motion tweening, 293, 295
purpose of, 364
Editable TLF text fields, 69, 70, 73
Edit bar, 20
Edit Envelope dialog, 514, 517–520
Edit Grid command, 22
Edit Guides command, 23
Edit in Place command, 159, 208
Edit Multiple Frames mode, 246–247
Edit Selected command, 158, 159
Edit Snapping dialog, 27
Edit Stroke Style button, 45
embedded fonts, 93
embedded video, 522, 526–529, 534
EMF files, 492
encoding options, 521
End Angle field, 52
end-link pointer, 82
end margin, 96, 97
Enhanced Windows Metafile format, 492
Erase Lines setting, 148
Erase Normal setting, 153
Eraser Mode menu, 148
eraser tool, 148, 153
Essentials workspace, 9
event handlers, 451, 457–458, 470–471
events
defined, 451
handling multiple, 470–471
mouse, 448, 466
rollover, 463–465
event sounds, 508–511
exporting movies, 543, 544

F

F4V files, 521, 522, 532
fade effects, 38, 269, 517–518, 519
Faucet mode, 148
feedback, auditory, 506
file formats
and ActionScript versions, 4
choosing, 4
for images/graphics, 492
for movies, 543
for sounds, 500
Fill Color control, 40–42, 126
fill paths, 136, 155
fills
adding to shapes, 63–67
changing, for multiple selections, 125
changing center point for, 129
choosing colors for, 33
converting strokes to, 149
defined, 31
editing across layers, 181
interaction of merge-shapes and, 155
interaction of strokes and, 156
intersecting, 155
modifying, 126–132
rotating, 132
fills (continued)
   setting attributes for, 40–42
   shape-tweening with strokes, 277–278
   and TLF background colors, 104
   transforming, 275–276
filters, 367, 370, 371, 521
Filters section
   Motion Editor, 308, 309
   Property inspector, 85
Fire Animation pattern, 169
Fireworks, 489, 491
FLA files, 436, 537
Flame Brush pattern, 67, 169
Flash CS3, 218, 288
Flash CS4, 70, 73, 82, 218, 288
Flash CS4 Professional Visual QuickStart Guide, 73
Flash CS5
   accessibility features, 542
   ActionScript versions, 432
   advanced book on, 320
   authoring environment, 1, 8–10
   creating interactivity in, 431 (See also interactivity)
   documentation, 28
   drawing tools, 29, 30
   graphic-object types, 48
   Help options, 1, 28
   importing graphics to, 489
   and tweening, 249, 271
Flash documents, 2–5
   changing tab order for open, 5
   components of, 10
   creating, 4
   Edit bar, 20
   opening, 3, 5
   setting launch preferences for, 2
   setting units of measure for, 18
   viewing multiple open, 5
Flash Exchange site, 3
Flash files, 4. See also Flash documents; SWF files
Flash Help command, 28
Flash Lite, 541
Flash Player, 546–559
   choosing version of, 547
   installing, 537
   opening, 546
   playing through frames in, 239
   previewing movies in, 454
   publishing HTML for, 558–559
   purpose of, 546
   working with settings for, 546–557
Flash Player format, 492, 537
Flash section, Publish Settings dialog, 543–544, 545
fps, 241, 242. See also frame rate
frame actions
   adding, 437–440
   creating, 436
   creating separate layer for, 437
   organizing, 437
frame-by-frame animation, 215–248
   combining with tweening, 355
   creating bouncing ball with, 236–246
   defined, 235
   editing multiple frames in, 246–247
   examples of, 215, 235
   how it works, 215
   making simple, 235–237
   practice session, 248
   previewing, 238–239
   setting frame rate for, 241
   smoothing, 237, 242–243
   using onion skinning for, 244–245
   varying speed of, 242–243
   when to use, 217
frame labels
   assigning to button-state keyframes, 428–429
   creating, 459–460
   naming, 429
   sending playhead to, 461
   targeting, 461
frame points, 296
Frame Property inspector, 261, 262, 263
frame rate
   for film, 242
   how it works, 242
   FLV files, 499, 521, 522, 532
   FLVPlaybackCaptioning component, 542
   FLVPlayback component, 530–535
   animating, 533
   changing size of, 531
   changing skin for, 533–534
   choosing source video for, 530–531
   choosing starting volume for, 531
   defined, 532
   and published movies, 535
   reusing, 532
   and Video Import Wizard, 522, 532
flying-bird animation, 270, 372, 408, 536
focal point, 130
Folder hot text, 199
folders
   configuration, 7
   layer, 173–179
   library, 210
Font Embedding dialog, 93
font families, 87
Font menu, 87
font-rendering methods, 92
fonts
   choosing character style, 88
   embedding, 93
   and kerning, 91
   sizing/resizing, 88
   for TLF vs. Classic text, 82
font symbols, 195
Formats section, Publish Settings dialog, 543–544, 545
fps, 241, 242. See also frame rate
frame actions
   adding, 437–440
   creating, 436
   creating separate layer for, 437
   organizing, 437
frame-by-frame animation, 215–248
   combining with tweening, 355
   creating bouncing ball with, 236–246
   defined, 235
   editing multiple frames in, 246–247
   examples of, 215, 235
   how it works, 215
   making simple, 235–237
   practice session, 248
   previewing, 238–239
   setting frame rate for, 241
   smoothing, 237, 242–243
   using onion skinning for, 244–245
   varying speed of, 242–243
   when to use, 217
frame labels
   assigning to button-state keyframes, 428–429
   creating, 459–460
   naming, 429
   sending playhead to, 461
   targeting, 461
frame points, 296
Frame Property inspector, 261, 262, 263
frame rate
   for film, 242
   how it works, 242
frames. See also keyframes
adding sounds to, 502–504
commands for working with, 219
converting protoframes into, 216
converting to keyframes, 222
copying and pasting, 228–229
copying selected, 337
creating in-between, 223, 224
displaying contents of, 216
editing multiple, 246–247
identifying tweening in, 251
manipulating, in layers, 228–231
manipulating, in multiple layers, 335–338
moving with drag and drop, 230–231
pasting multiple-layer selection into blank, 338
printing, 537
removing, 232–234
replacing content of, 337
selecting, 225–227
sending playhead to specific, 458–459
undoing modifications to, 231
viewing in Bandwidth Profiler, 539
viewing in Timeline, 216, 217–218
frame scripts, programming buttons with, 442–449
frames per second, 237, 241, 242. See also frame rate
Frame View menu, 217, 218
free-form shapes, 53–62
free-form solid fills, 58–60
FreeHand, 489
free-transform tool, 113, 122–118, 123–125
functions, 451, 453
FutureSplash Animator, 547
FutureSplash Player files, 492

G
Gap Size menu, 65
Generate Size Report command, 541, 553
gemetric fills, 49
gemetric outlines, 46–47
gemetric shapes, 46–52. See also shapes
gemetric-shape tools, 47
GIF files, 492, 537
Global Security Settings tab, 556, 557
gradients
adding to Swatches panel, 39
changing center point for, 129
controlling overflow for, 132
and drawing modes, 62
and file size, 66
filling outline shapes with, 66
linear, 36–37
locked, 129
painting with, 60–62
radial, 38
resizing, 130–131
rotating, 132
saving, 39
gradient-transform tool, 129, 130–131
graphic objects, types of, 46
graphics, 105–191. See also images; shapes
controlling stacking order for, 160–161
converting symbol instances to, 211
converting to symbols, 197–199
creating button states with, 415–416
creating simple, 29–68
cutting and pasting, 182–184
distorting, 123–125
distributing to layers, 185
flipping, 119
how Flash tracks, 118
importing, 490–491
inline, 76, 100
modifying simple, 105–152
on multiple layers, 171–191
positioning, 117
resizing, 113–116
rotating, 120–122, 265–267
shape-tweening moving, 283–284
on single layer, 153–170
skewing, 121–122
spinning, 267
tools for creating, 30–32
using non-Flash, 489–498
gradients
animated, 359, 360–361
and classic tweening, 250
converting animations to, 357–358
vs. other types, 199
Grid Fill pattern, 67, 166, 169
grids
filling space with repeating, 166–168
setting parameters for, 22
showing/hiding, 21
snapping to, 24, 26
Group command, 156
group objects, 67
groups, 156–159
creating, 156
defined, 156
and Distort Modifier, 125
editing contents of, 158–159
nested, 159
guide layers, 172, 186–187
guides
assigning precise location to, 23
locking, 23
moving, 23
setting parameters for, 23
showing/hiding, 21
snapping to, 25, 26
vs. motion guides, 186
H
hairline strokes, 44
head, of bone, 378, 392–394
height, stroke, 43
Height hot text, 114–116
Help options, 1
hex colors, 33, 42
Highlight color control, 94
highlight pattern, 107
Hinting checkbox, 45
Hit keyframe, 414
Hit state, 412, 416, 427
hollow bullet, 216
Horizontal Scale property, 263
Horizontal Spacing option, 167
hot text, 14
HSB values, 35
HTML
documents, 558–559
tags, 560
templates, 559, 560, 561
HTML section, Publish Settings dialog, 558–559
hyphenation, 100
I
Identifiers, 450
If statements, 452
IK. See also inverse kinematics
animation, 373, 377, 389
author-time vs. runtime, 390
drawing preferences, 374
instance naming, 379
meaning of acronym, 373
shapes, 381–383, 402–403
tools, 388
IK Armature Property inspector, 390
Illustrator, 489, 491, 492
images. See also graphics
bitmap (See bitmaps)
flowing text around, 76
for frame-by-frame animation, 235
inline, 76, 100
for traditional animation, 215
Import command, 489
importing, 490–497
bitmaps, 490–491
to Library vs. Stage, 491
Photoshop files, 492–497
series of graphics files, 491
sounds, 500–501
video, 521–527
Import statement, 450
Import to Library command, 490, 491
Import to Stage command, 490, 491, 497
Import Video dialog, 523, 524, 525, 526
in-betweeners, 224
in-between frames
creating, 223, 224
extending tween spans with, 326
varying animation speed by adding, 242–243
vs. keyframes, 224
inches, 18
indents, 97
Info panel, 116, 200
ink-bottle tool, 63–64, 125, 128
inline graphics, 76, 100
Input text, 70
Insert commands, 223
Insert Frame command, 243
Insert > Keyframe command, 332
Insert Target Path button, 481
instances, 195, 450. See also symbol instances
interactive buttons, 409, 430
interactive environments, 409
interactive objects, 466
interactive pattern brushes, 169
interactive websites, 431
interactivity
best way to create, in Flash, 431
defined, 436
practice session, 487–488
scripting for, 451, 468–469
using ActionScript to create, 431 (See also ActionScript)
international typography, 92
Internet connection speeds, 538, 541
Internet Explorer, 560. See also web browsers
Intersect command, 163
intersecting fills, 155
inverse kinematics, 373–408
author-time vs. runtime, 390
constraining IK motion, 391–400
creating IK shapes, 381–383
defined, 373
and easing, 367, 407
editing IK elements, 401–407
incorporating into symbols, 389
and instance naming, 379
and motion tweens, 355
and pose layers, 380
practice session, 408
saving as symbols, 389
using armatures to connect symbols, 374–377
vs. shape tweening, 273
when to use, 388
working with poses, 384–389
iPhone applications, 547
J
Join styles, 43, 44, 45
joints, 378
JPEG compression, 494, 548
JPEG files, 492
Justified Text, 90, 96, 101
Justify button, 101
JVT, 522
K
Kerning, 91
keyboard shortcuts, 31, 31, 312
Keyframe command, 219, 221, 222, 332
Keyframes
adding to classic tweens, 256
assigning sounds to, 502–504
blank, 216, 219–220, 221, 222
for bouncing-ball animation, 235–236
creating, 219–220, 236
defined, 215
duplicating, 221, 332
designing multiple, 246–247
how Timeline displays, 216
inserting vs. adding, 221
inserting vs. converting, 222
position, 292, 302, 314–316
removing, 232
rotation, 292, 319
roving, 294–295
setting up initial, 235
for traditional animations, 235
vs. in-between frames, 224
keyframe spans
creating blank keyframe within, 220
deleting frames from, 233
extending, 231
purpose of, 216
reversing frame order for, 351–352
selecting frames in, 225–227
keywords, 435, 553

L
Labels layer, 459–460
Lasso tool, 111, 112
Last Documents Open option, 2
launch preferences, 2
layer comps, 497
layer folders, 173–179
adding/deleting, 173–174
hiding/showing contents of, 176
locking/unlocking, 177
moving into open folders, 179
purpose of, 172
renaming, 175
reordering, 178
viewing in Outline/Solid mode, 177
layer properties, 175–177
layers, 171–191
activating, 180
adding/deleting, 173–174
adjustment, 494
allowing elements to span multiple, 349
animating on multiple, 339–350
assigning actions to, 437
cutting/pasting between, 182–184
distributing graphic elements to, 185
editing fills across, 181
editing shapes on inactive, 180–181
guide, 172, 186–187
hiding/showing contents of, 176
how Flash represents, 172
importing, 492–493, 496
interaction of merge-shapes on, 154, 156, 157
locking/unlocking, 177
manipulating frames in, 228–231
manipulating frames in multiple, 335–338
mask, 188–190
merging for import, 496
moving into open folders, 179
organizing, 178–179
pose, 376, 380
renaming, 175, 497
reordering, 178
selecting multiple, 174
setting properties for, 175–177
stacking order on, 160–161, 171
viewing in Outline/Solid mode, 177
leading, 89
letterspacing, 90
libraries
common, 196
creating new folders in, 210
deleting symbols from, 209–210
importing to, 491
opening, 194, 196
terminology, 195
viewing, 195
library folders, 210
Library panel
buttons/controls for, 194
duplicating symbols in, 206
opening, 194
purpose of, 194
viewing libraries in, 195
ligatures, 91, 98
Lightening Brush pattern, 67, 169
Limelight Networks, 522
linear armatures, 374–377, 378
linear gradients, 36–37
line breaks, 100
line-drawing modes, 53
lines. See also strokes
attributes for, 43
converting to fills, 149
transforming, 275–276
turning into curves, 135
line weight, 43
linked text fields, 76–81
Link Values icon, 319
loaded-text pointer, 82
local-only access, 555
Local Playback Security setting, 556
locked gradients, 129
Lock Fill modifier, 61, 62
Lock Guides command, 23
Loop Playback command, 239, 493
Lossy compression, 494

M
Macintosh
floating panel window, 11
sound formats, 500
Make Default button, 19
margins, 97
masking, 82
mask layers, 188–190
master symbols, 208–210
breaking symbol's link with, 211
deleting, 209–210
duplicating, 206
editing, 208
Max Chars setting, 102
Media Encoder, Adobe, 499, 521
Merge Drawing mode
creating shapes in, 29
and gradients, 62
and intersecting merge-shapes, 154–155
vs. other modes, 48
merge-shapes
changing fills/strokes for multiple, 125
combining multiple, 163
converting shape type for, 150
converting text into, 151
editing, on inactive layers, 180–181
merge-shapes (continued)
  interaction between, 154–155, 156, 157
  and layers, 154, 160
  modifying, 133
  resizing, 115
  selecting, 107–108
  and shape tweening, 273
  and stacking order, 160
  undoing changes to, 121
  vs. other types of graphic objects, 48
Microsoft
  Active Accessibility technology, 542
  Internet Explorer, 560 (See also web browsers)
  Windows (See Windows)
Miter join style, 44, 45
modifier icons, 133
Modify Onion Markers menu, 245, 246
motion
  constraining IK, 391–400
  copying, 369–371
  easing (See easing)
  guides, 260–261, 262
  paths (See motion paths)
  presets, 295
  reversing, 351–356
  tweening (See motion tweening)
  using custom easing to create, 364, 368
Motion Editor, 308–323
  adding keyframes to property curves in, 312, 313
  adding/removing position keyframes in, 314–316
  and custom easing, 368
  customizing graph views in, 311
  editing curves in, 322–323
  and property keyframes, 292, 312
  purpose of, 308
  removing keyframes from property curves in, 312, 313
  rotating tween targets in, 317–318
  shortcuts for navigating, 309
  viewing property curves in, 308–309
  vs. other methods of editing motion, 318
  vs. Timeline, 309–310
motion-guide layers, 259–260
motion guides, 186, 187, 260–261, 262
motion paths, 297–302
  adding/removing control points in, 301
  drawing new, 306
  mystery of, 296
  repositioning, 297
  reshaping, 299
  resizing, 298
  reversing direction of, 354
  swapping, 306–307
  transforming to arcs, 300
motion presets, 295
motion reversal, 351–356
Motion Tween command, 290, 295
motion tweening, 287–332. See also motion tweens
  best practices, 288
  copying and pasting, 330–331
  creating bouncing ball with, 288–293
  and Flash versions, 288
  how it works, 288
  and motion-tween paths, 297–302
  and Orient to Path option, 303
  practice session, 332
  swapping tween targets in, 304–307
  vs. classic tweening, 251, 287, 288
motion-tween paths, 297–302. See also motion paths
  Motion Tween Property inspector, 297, 298, 303, 318
  motion tweens. See also motion tweening
  autorotation in, 319
  combining with other types, 289
  and custom easing, 367, 368
  and inverse kinematics, 355
  multiple-layer, 344–348
  re-creating, 369–371
  reversing direction of, 353–354, 356
motion-tween spans. See also tween spans
  copying and pasting, 330
  drawing directly in, 306
  making selections in, 225
  and Motion Editor, 309
  number of symbols in, 290
  tinting of, 324
motion-tween symbols, 288
mouse events, 448, 466
  mouseMove event, 466
Move Guide dialog, 23
MOV files, 500, 544
movie-clip buttons, 426–429, 472, 476
MovieClip class, 450
movie-clip symbols
  animated, 359, 362–363
  converting animations to, 358
  as interactive objects, 466
  placing instances of, 362
  scripting to act as buttons, 472–476
  vs. other types, 199
movies. See also video
  adding button component to, 467
  adding keyframes to, 242–243
  controlling playback of, 239
  exporting, 537
  file-size considerations, 538, 541
  placing buttons in, 413
  preparing for optimal playback, 538–541
  previewing, 238–239
  printing, 537
  publishing, 543–545
  quality issues, 538
  removing frames from, 232–234
  scrubbing through, 238
  setting frame rate for, 241
  MP3 compression, 552
  MP3 format, 500
MSAA technology, 542
multicolumn text, 70, 83, 100, 102
multidirectional text, 92
Multiline behavior, 99, 100
multiline delimiters, 428
Multiline No Wrap behavior, 99
multimedia projects, 499
multinational text, 92
multiple-shape tweens, 277–278
N
naming/renaming
  components, 420
  frame labels, 429
  instances, 379, 450
  layer folders, 175
  layers, 175, 497
nested objects, 477
network-only access, 555, 556
New Document dialog, 4
New Document option, 2
New Folder button/command, 210
New From Template dialog, 7
New Symbol button/command, 201
New Workspace dialog, 9
nodes, 379
No Document option, 2
non-contact-sensitive selection rectangles, 111–112
numeric values, 14

O
Object Drawing mode, 29, 47, 48, 62
object-level undo, 210
Omit Trace Actions option, 554
onion skinning, 244–245, 247, 255, 303, 348
On Launch options, 2
Open As Library dialog, 196
open-link icon, 82
OpenType fonts, 11, 70, 98
operators, 452
Orient to Path mode, 262
Oval Options section, Property inspector, 52
operators ( ), 441
parentheses ( ), 441
Parentheses button, 7
Paraphrase behavior, 102
password fields, 102
Pasteboard, 17
Paste Frames command, 228, 330, 337, 338
Paste in Center command, 182
Paste in Place command, 183–184
Paste Motion command, 369, 371
Paste Pose command, 389
pasting modes, 183
paths
  adding points to, 143, 301
  closing, 140
  copying and pasting, 306
  creating open, 56
  defined, 58
  extending, 140, 143
  math for creating, 58
  modifying, 105, 144–147
  moving symbols along, 259–261
  orienting tween target to curved, 303
  removing points from, 301
  repositioning, 297
  reshaping, 299
  resizing, 298
  swapping, 306–307
  target, 477–478, 481
  viewing, 136
pattern brushes, interactive, 169
patterns, creating/customizing, 164–169
Pattern Scale option, 167, 168
pattern tools, 67, 164
pencil tool, 53, 54
pen tool, 53, 55–57, 140
Permit Debugging option, 554
Perspective button, 7
Photoshop, 489, 491, 492–497
Ping-Pong game, 339–348
pixels, 18
playback, preparing movies for optimal, 538–541
Play command, 239
paragraph attributes, 95–97
paragraphs
  creating space between, 97
  indenting, 97
  setting alignment for, 95–96
  setting margins for, 97
Paragraph settings, Text Edit mode, 84, 85
parameter hints, 444
parameters
  for button components, 422, 423, 424
  for button states, 420
  for events, 446
  for FLVPlayback component, 530
  for functions, 453
  for grids/guides, 22–23
  for patterns, 164, 167
  for snapping to grids/guides, 26
  for sounds, 508
  for Stage, 16
parent bones, 375, 378
padding, 102
paint-bucket tool, 63, 65–66, 125, 126, 132
painting
  with gradients, 60–62
  random dot pattern, 164–166
Paint Normal setting, 153
Paint Over Edge checkbox, 168
panels, 11–15. See also specific panels
  accessing, 11
  modifying fills/strokes in, 127
  opening/closing, 12
  purpose of, 11
  resizing, 13
panel windows, 12
paragraph attributes, 95–97

preferences
ActionScript, 2, 434–435
Actions panel, 434–435, 447
AI File Importer, 2
Auto Format, 2
drawing, 2, 53, 374
keyframe span, 225
launch, 2
PSD File Importer, 2
PSD import, 492–494
text, 2
tool tips, 31
warnings, 2
Pressure modifier, 59
primitive-shapes
changing fills/strokes for multiple, 125
combining multiple, 162
converting drawing-objects to, 150
converting merge-shapes to, 150
defined, 29
modifying, 133, 144–147
resizing, 115
selecting, 107, 108
and shape tweening, 273, 285
undoing changes to, 121
vs. other types of graphic objects, 47, 48
primitive tweens, 285
Printer radio button, 18
printing
frames/movies, 537
message in Output window, 457–458
progressive-download video, 521, 535
projectors, 537, 543
property curves
adding/removing keyframes in, 312, 313
editing, 322–323
viewing, 308–309
Property inspector
Component Parameters section, 421, 422, 423–424, 530, 532
Oval Options section, 52
positioning graphics with, 117
resizing elements with, 116
setting fill colors in, 40–42
setting paragraph attributes in, 95–97
setting text attributes in, 84–94
property keyframes
copying and pasting, 331
hiding, 305
how they work, 292
how Timeline indicates presence of, 292, 302
and Insert > Keyframe command, 332
manipulating tween targets to add, 317
navigating, 312
removing, 329
reversing order of, 355
Protect from Import check box, 554
protoframes, 216, 219, 222, 225
PSD File Importer, 2, 492
PSD files, 492–497
PSD Import dialog, 492, 495, 497
publishing. See also Publish Settings dialog
digitally recorded sounds, 550
HTML documents, 558–559
movies, 545
practice session, 562
setting format for, 543–544
SWF files, 546
vs. exporting, 543, 544
publishing formats, 543
Publish Preview command, 545
Publish Settings dialog, 543–555
and ActionScript versions, 548
Flash section, 546–555
Formats section, 543–544, 545
HTML section, 558–559
Punch command, 163
Q
QT format, 500
QTIF files, 492
QuickTime, 500, 544
QuickTime Image files, 492
radial gradients, 38, 130–131
RadioButton component, 467
ragged text, 95, 96
random dot pattern, 164–166
Random Order checkbox, 168
Random Scaling checkbox, 166
range-of-motion icons, 396
raw compression option, 552
raw shapes, 48
Readability option, 92
Read Only TLF text fields, 69, 70, 72
rectangle-primitives, shape tweening, 285
rectangle-primitive tool, 144–146
rectangles, transforming, 275–276
rectangle tool, 50
red plus sign, 76
registration crosshair, 202
registration grid, 198, 199, 200
registration point, 116, 118, 200, 202, 383, 494
Registration/Transformation Point model, 116, 118, 200
relative target paths, 477–478, 481
Remove Frames command, 232, 233, 234
Remove Hint command, 282
Remove Transform button, 115, 121
renaming. See naming/renaming
repetitive patterns, 169
Reset button, 121
resizing
drawing-objects, 115
gradients, 130–131
graphics, 113–116
merge-shapes, 115
motion paths, 298
primitive-shapes, 115
Swatches panel, 39
text fields, 115
tween spans, 325
Reverse Frames command, 352
Reverse Keyframes command, 355, 356
Reverse Path command, 353
RGB values, 35, 207
rollover event, 466
rollover buttons, 417–418
rollover event, 466
rollover events, 463, 466
Rotate and Skew modifier, 122
Rotate hot text, 120
rotating
gadients/fills, 132
graphics, 120–122, 265–267
symbols, 265–267
rotation
2D vs. 3D, 320
constraining, 392–394
keyframes, 292, 319
Rotation Count hot text, 266, 267
Rotation Z hot text, 317
Round join style, 44, 45
roving keyframes, 294–295
RSL files, 549
rulers, 21, 23
Ruler Units menu, 18
runtime errors, 456
runtime IK, 390
runtime shared library, 549
sampled sounds, 500
sample rates, 550, 551, 552
Save As command, 444
Save As Template command, 6
Save Colors command, 39
Scale Height hot text, 114–116
Scale hot text, 164
Scale modifier, 113, 119
Scale Width hot text, 114–116
Scale X/Y hot text, 317, 319
Scene panel, 334
scenes, 334, 360
screen-reading software, 542
Script Assist mode, 439
script identifiers, 450
scripting. See also ActionScript
adding comments to, 429, 437–440, 450
for adding frame actions, 438–440
checking syntax of, 454–455
color-coding, 435
coloring errors in, 455
defined, 432
downloading from companion website, 432
how this book presents, 432, 446
programming buttons with frame, 442–449
reusing, 449
saving segments of, 444
testing, 456
using if statements in, 452
scrubbing, 238, 514
SD2 format, 500
security settings, 556–557
segments, 154
Selectable TLF text fields, 69, 70, 72
selection icon, 107
selection rectangles, 110–112
selections
adding elements to, 109
changing fills/strokes for multiple, 125
making, 107–112
in motion-tween spans, 225
selection tools, 133–135, 300
semicolon (;), 441
Send Backward command, 161
Send to Back command, 161
shape-changing button symbols, 415–416
shape hints, 280–282
shapes. See also graphics
adding strokes/fills to, 63–67
shapes. See also graphics (continued)
  binding control points of, 404
  creating free-form, 53–62
  creating geometric, 46–59
  cutting and pasting, 182–184
  deselecting, 133
  modifying, 133–148
  morphing along a curve, 285
  preventing interactions between, 157
  smoothing, 54
  straightening, 54
  transforming simple to complex, 279–282
  types of, 29, 149
  shape tweening, 271–286
    applying, 273
    complex shapes, 279–282
    creating bouncing ball with, 272–274
    and custom easing, 367
    morphing simple lines/fills with, 275–276
    moving graphics, 283–284
    multiple-layer, 349–350
    multiple shapes, 277–278
    practice session, 286
    preparing content for, 272
    and primitive-shapes, 273, 285
    vs. classic tweening, 273
    vs. inverse kinematics, 273
  shape types, converting, 149–151
  shortcuts, keyboard, 143
  Show Grid command, 21
  Show Guides command, 21
  Show Masking command, 190
  Show Shape Hints command, 282
  sibling bones, 379
  SimpleButton class, 450
  Single Line behavior, 99
  Size Report, 538, 541, 553, 562
  Skew Horizontal/Vertical hot text, 121
  skewing elements, 121–122, 124
  Skew X/Y hot text, 320
  skins, 425, 524, 531, 533–534
  Small Screen workspace, 9
  Smoke Animation pattern, 169
  smoothing
    frame-by-frame animations, 237, 242–243
    shapes, 54
  Smoothing setting, brush tool, 60
  Smooth mode, 53, 54
  Snap Accuracy menu, 22, 26
  Snap Align feature, 24, 25, 27, 187
  snapping features, 24–27
    setting parameters for, 26
    turning on/off, 24–25
  Snap to Grid feature, 24
  Snap to Guide feature, 24, 187
  Snap to Objects feature, 24, 187, 260
  Snap to Pixels feature, 24, 25
  SND format, 500
  snowflake button, 427
  solid-color attributes, 33
  Sort by Color command, 39
  Soundbooth, 500
  sound compression, 555
  Sound Designer II, 500
  sound effects, 501, 504. See also sounds
  sound formats, 500
  sound layers, 505
  Sound Properties dialog, 555
  sounds, 499–520
    accessing library of, 501
    adding to buttons, 506–507
    adding to frames, 502–504
    changing volume of, 517–519
    creating separate layers for, 505
    editing, 517–520
    event, 508–511
    importing, 500–501
    independent vs. synchronized, 508
    and library terminology, 195
    listening to, 501
    organizing, 505
    publishing digitally recorded, 550
    removing dead air from, 520
    setting compression options for, 555
    start, 512
    stopping, 515–516
    stream, 513–514
    testing, 508–509
    using buttons to control, 516
  Sound Settings dialog, 551
  spacing
    paragraphs, 97
    words/letters, 90
  span-based selection style, 225, 227, 231
  spans
    applying easing to, 365–366
    pose, 216, 385, 388, 389
    tween (See tween spans)
    types of, 216
  Speech compression option, 552
  spinning symbols, 267
  SPL files, 492
  spray-brush tool, 67, 164–165
  Spray Brush Tool Property inspector, 164–166
  Spring properties, 395
  sprites, 477
  stacking order, 160–161, 171
  Stage
    entering symbol-editing mode from, 208
    importing to, 491
    placing graphic elements on, 21
    relocating animated graphics on, 246–247
    setting size of, 17–18
    viewing at different magnifications, 20
  Start Angle field, 52
  start margin, 96, 97
  start sounds, 512
  Static text, 70
  stop() action, 487
  storyboards, 224, 537
  straightening shapes, 54
  Straighten mode, 53, 54
  streaming
    sound, 513
    TV shows, 541
    video, 521, 535
Streaming Graph mode, 540
stream sounds, 513–514
Strength value, 395
strike-through text, 94
Stroke Color control, 43–45, 126
stroke height, 43
strokes. See also lines
  adding to shapes, 63–67
  changing, for multiple selections, 125
  choosing colors for, 33
  constraining scaling of, 45
  converting to fills, 149
  defined, 31
  interactions between fills and, 156
  modifying, 126–132
  setting properties for, 43–45
  setting style for, 44
  shape-tweening fills with, 277–278
  and TLF border colors, 104
  transforming, 275–276
Stroke Style dialog, 45
stroke styles, 44, 45
Style menu, 88
subscripts, 94
subselection tool, 133, 136, 143, 147
Sun AU files, 500
superscripts, 94
Swap button, 212
Swap Symbol dialog, 212–213
Swatches panel, 38, 39, 127
.swf extension, 239, 456
SWF files
  compressing, 552
  controlling access to, 554, 555
  embedding fonts in, 93
  embedding video in, 521
  extension for, 239
  how Flash stores, 239
  password-protecting, 554
  publishing, 449, 546
  viewing in Flash Player, 537
SWF History feature, 541
SWZ files, 17, 240
symbol-editing mode, 201, 202, 203, 208
symbol instances, 203–213. See also symbols
  breaking link to, 211
  converting to graphics, 211
  defined, 203
  and IK animation, 377
  linking in linear armatures, 375–377
  modifying, 204–207
  placing in movies, 203
  swapping one for another, 212–213
symbols, 197–202. See also symbol instances
  animating change in size of, 263–264
  changing color over time, 268–269
  and classic tweening, 252
  converting animations to, 357–358
  converting graphics to, 197–199
  creating from scratch, 201–202
  defined, 195
  and Distort Modifier, 125
  duplicating, 206, 213
editting, 202, 208
moving along paths, 259–261
moving in straight lines, 257–258
positioning tweened, 253
practice session, 214
reducing layer buildup with, 359
registration point for, 200, 202
rotating/spinning, 265–267
swapping, 305
switching, 212–213
testing interactivity of, 456
transformation point for, 200
transforming, 204
and tweening types, 250
types of, 199
using IK armatures to connect, 374–377
symbol types, 199, 206, 414, 526
Symmetry Brush pattern, 169
synchronized sounds, 508
Sync setting, 512, 513, 515
syntax, ActionScript, 441, 454–455
System 7 sounds, 500
System Color Picker, 42

T
Tab bar, 13
tail, of bone, 378
tangent handles, 58
targeting frame labels, 461
target instances, 287
target paths, 477–478, 481
template documents, 6–7, 28
template variables, 560
test modes, 454
Test Movie command, 239, 240, 456
Test Scene command, 240, 243, 363, 456
text, 69–104. See also text fields
  anti-aliasing, 87, 92
  breaking apart, 151
  converting TLF to Classic, 83
  flowing, 70, 83
  highlighted, 94
  images amid, 76
  justified, 90, 101
  links, 482–483
  multicolumn, 70, 100, 102
  multidirectional, 92
  multinational, 92
  non-wrapping, 72–73
  point vs. area, 71
  preferences, 2
  ragged, 95, 96
  selecting, 86
  setting character attributes for, 84–94
  setting paragraph attributes for, 95–97
  strikethrough, 94
  threaded, 76, 86
  underlined, 94
  vertical vs. horizontal, 92
  wrapping, 74–75
text-alignment methods, 96
text color, 91, 94
Text Edit mode, 84
Text Engine menu, 72
text-field containers, 71
text fields, 69–104
  animated, 92
  breaking links between, 80–81
  creating backgrounds for, 103
  creating borders for, 103
  creating linked, 76–77
  creating multicolumn, 100
  defined, 71
  and Distort Modifier, 125
  limiting amount of text entered in, 102
  linking manually, 78–79
  positioning columns within, 101–102
  resizing, 75, 115
  selecting/modifying multiple, 85
  TLF vs. Classic, 69, 70–71, 82–83
text-flow indicators, 76
Text Layout Framework, 69, 70–71, 100. See also TLF
  text fields
text links, 482–483
Text Orientation menu, 92
text preferences, 2
Text (Tool) Property inspector, 84–85
text-threading icons, 82
text tool, 70, 72
Text Tool mode, 85
Text Tool Property inspector, 72
text wrap, 98–99
threaded fields, 76
threaded text, 76, 86, 95
three-dimensional tools, 124, 320
T icon, 70, 72, 85
TIFF files, 492
Tile Pattern option, 167
Timeline
  adding in-between frames to, 223
  buttons/controls, 10
  color coding in, 251
  copying and pasting frames in, 228–229
  and Flash versions, 218
  how frames/spans are presented in, 216
  layer features, 172
  manipulating pose spans in, 389
  moving frames in, 230–231
  optimizing, 217
  placing embedded video in, 528–529
  purpose of, 10
  selecting frames in, 225–227
  using buttons to control, 477–480
  viewing frames in, 216, 217–218
  vs. Motion Editor, 309–310
Tinted Frames option, 251
Tint settings, 205, 207, 309
TLF SWZ files, 17, 240, 549–550
TLF text fields, 69–104
  and advanced ActionScript settings, 549–550
  breaking links between, 80–81
  controlling text wrap for, 98–99
  converting to Classic text fields, 83
  converting to drawing-objects, 150–151
  creating, 72–75
  creating linked, 76–77
  creating solid outlines for, 42
  linking manually, 78–79
  and masks, 189
  meaning of acronym, 69
  playback requirements, 71
  setting character attributes for, 84–94
  setting container attributes for, 98–103
  setting paragraph attributes for, 95–97
termology, 96
  testing, 240
  and text selection, 86
types of, 69, 70, 72
  vs. Classic text fields, 70, 82–83
toggle buttons, 424
Tolerance settings, 53
Tools panel, 30–32, 40–42
tool tips, 31
touch screens, 413
trace actions, 554
Trace and Debug options, 554
tracking, 90, 91
transformation point, 116, 118, 200
Transform panel, 114–115, 120, 121, 204, 319
Transform submenu, 119, 120
translation, translating direction of, 391
transparency
  for colors, 36
  for gradients, 38
  for symbol instances, 206
  using classic tweening to change, 269
Tree Brush pattern, 169
TrueType fonts, 11, 70, 98
tutorials, 3
tweened symbols, positioning, 253
tweeners, 224
tweening
  classic (See classic tweening)
  color changes, 268–269
  combining with frame-by-frame techniques, 355
  identifying frames with, 251
  motion (See motion tweening)
  shape (See shape tweening)
types of, 249, 251
tweens, broken, 251
tween spans
  and bouncing-ball animation, 289
  cutting frames out of, 327
  extending/trimming end of, 326
  how Flash determines length of, 290
  modifying, 324–329
  moving with drag and drop, 328
  purpose of, 216
  removing property keyframes from, 329
  resizing, 325
  reversing, 356
  selecting, 324
  shortening, 327
tween targets
  changing color of, 321
  changing position of, 291–293
  changing scale of, 319–320
defined, 287
editing movement of, 318
making two follow same path, 307
and motion paths, 296
orienting to curved paths, 303
rotating, 317–318
swapping, 304–305
Type 2 fonts, 98. See also OpenType fonts
typography
baselines, 99
kerning, 91
text-alignment methods, 96

U
UI elements, 419
Unconstrain modifier, 102, 114–115, 116, 319
underlined text, 94
Undo command, 121, 125, 210, 231
Ungroup command, 156
Union command, 162, 163
units of measure, 18
Up keyframe, 414
Up state, 411, 415–416, 426
URLs, linking to, 482–486
Use Device Fonts option, 92
user interactions, 451
user interface elements, 419

V
vanishing point, 124
vector graphics, 489, 537
Vertical Scale property, 263
Vertical Spacing option, 167
vertical text, 92
video. See also movies
compression, 522
embedded, 522, 526–529, 534
importing, 521–527
progressive-download, 521, 535
streaming, 521, 535
video clips, 195. See also video
Video Import Wizard, 521, 522, 530, 532
Viewable Frames hot text, 311
Vine Fill pattern, 67, 169
visually impaired users, 542
Visual QuickPro Guide, Flash Professional CS5
Advanced for Windows and Macintosh, 320
Visual QuickStart Guide, Flash CS4 Professional, 73

W
Walt Disney studio, 215
Warner Bros. studio, 215
warnings preferences, 2
WAV format, 500
web browsers
displaying Flash content in, 537, 544, 560
and HTML tags, 560
opening Adobe Community Help in, 28
opening URLs in, 482–483
webcams, 541
web pages
background color for, 561
creating text link to, 482–483
scripting button to open, 483–486
website(s)
accessibility considerations, 542
creating consistent look for, 413, 422
interactive, 431
linking to, 432
this book’s companion, 11, 73, 82, 194, 432, 489
weight, line, 43
Welcome screen, 1, 2, 3
Width/Height hot text, 114–116
Window menu, 12
Windows
floating panel window, 11
sound formats, 500
Windows Metafile format, 492
WMF files, 492
word spacing, 90
word wrap, 74–75, 98–99
workspace
choosing, 9
creating, 28
defined, 8
restoring, 9
saving custom, 9
wrapping, text, 74–75, 98–99

X
XMP metadata, 552, 553
x-/y-coordinates, 117, 118, 159
X/Y hot text
positioning graphics with, 117
positioning motion paths with, 297, 307
positioning symbols with, 314, 315
positioning tweened symbols with, 253
positioning tween targets with, 318
x-/y-translation, 379, 388, 391, 397–400

Y
Y hot text. See X/Y hot text
YouTube, 541